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This is the hardware warranty.

Warranty

Tektronix warrants that the product will be free from defects in materials and workmanship for a period of three (3)
years from the date of original purchase from an authorized Tektronix distributor. If the product proves defective
during this warranty period, Tektronix, at its option, either will repair the defective product without charge for
parts and labor, or will provide a replacement in exchange for the defective product. Batteries are excluded from
this warranty. Parts, modules and replacement products used by Tektronix for warranty work may be new or
reconditioned to like new performance. All replaced parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix,
shipping charges prepaid, and with a copy of customer proof of purchase. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is
located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any other charges for
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any damage
or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or
integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE

AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

[W16 — 15AUG04]



This is the software warranty.

Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide

a replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer's requirements
or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER'S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user
for safe operation and to keep the product in a safe condition.

To safely perform service on this product, additional information is provided at
the end of this section. (See page x, Service safety summary.)

General safety summary

To avoid fire or personal

viii

injury

Use the product only as specified. Review the following safety precautions to
avoid injury and prevent damage to this product or any products connected to it.
Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow
generally accepted safety procedures in addition to the safety precautions specified
in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove
the cover for repair, maintenance, or adjustment.

This product is not intended for detection of hazardous voltages.

While using this product, you may need to access other parts of a larger system.
Read the safety sections of the other component manuals for warnings and
cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the
responsibility of the assembler of the system.

Use proper power cord. Use only the power cord specified for this product and
certified for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded.

Power disconnect. The power cord disconnects the product from the power
source. See instructions for the location. Do not position the equipment so that it
is difficult to disconnect the power cord; it must remain accessible to the user at
all times to allow for quick disconnection if needed.
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Important safety information

Use proper AC adapter. Use only the AC adapter specified for this product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

The measuring terminals on this product are not rated for connection to mains or

Category I, III, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels
removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components
when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged
or operates incorrectly. If in doubt about safety of the product, turn it off and
disconnect the power cord. Clearly mark the product to prevent its further
operation.

Examine the exterior of the product before you use it. Look for cracks or missing
pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions. Be aware that condensation may occur if
a unit is moved from a cold to a warm environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean
the product.

Provide a safe working environment. Always place the product in a location
convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads.
Improper or prolonged keyboard or pointer use may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an
ergonomics professional to avoid stress injuries.
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Important safety information

Service safety summary

Terms in this manual

A

The Service safety summary section contains additional information required to
safely perform service on the product. Only qualified personnel should perform
service procedures. Read this Service safety summary and the General safety
summary before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power. To avoid electric shock, switch off the product power and
disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist
in this product. Disconnect power, remove battery (if applicable), and disconnect
test leads before removing protective panels, soldering, or replacing components.

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.
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Important safety information

Symbols and terms on the product

These terms may appear on the product:

B DANGER indicates an injury hazard immediately accessible as you read
the marking.

B WARNING indicates an injury hazard not immediately accessible as you
read the marking.

B CAUTION indicates a hazard to property including the product.
When this symbol is marked on the product, be sure to consult the manual
to find out the nature of the potential hazards and any actions which have to

be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbol(s) may appear on the product:

AN\

CAUTION
Refer to Manual

TekSmartLab User Manual X1



Compliance information

Compliance information

EMC compliance

Xii

EC Declaration of
Conformity - EMC

This section lists the EMC (electromagnetic compliance), safety, and
environmental standards with which the instrument complies.

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility.
Compliance was demonstrated to the following specifications as listed in the
Official Journal of the European Communities:

EN 61326-1 2006. EMC requirements for electrical equipment for measurement,
control, and laboratory use. 23

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A

IEC 61000-4-2:2001.
IEC 61000-4-3:2002.
IEC 61000-4-4:2004.
IEC 61000-4-5:2001.
IEC 61000-4-6:2003.

IEC 61000-4-11:2004.

Electrostatic discharge immunity

RF electromagnetic field immunity
Electrical fast transient / burst immunity
Power line surge immunity

Conducted RF immunity

Voltage dips and interruptions immunity

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European contact.

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic

interference.

Emissions which exceed the levels required by this standard may occur when this equipment is connected to a

test object.

For compliance with the EMC standards listed here, high quality shielded interface cables should be used.
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Compliance information

Australia / New Zealand
Declaration of
Conformity - EMC

Safety compliance

Equipment type

Pollution degree
descriptions

Pollution degree rating

TekSmartLab User Manual

Complies with the EMC provision of the Radiocommunications Act per the
following standard, in accordance with ACMA:

m  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in
accordance with EN 61326-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

This section lists other safety compliance information.

Test and measuring equipment.

A measure of the contaminants that could occur in the environment around
and within a product. Typically the internal environment inside a product is
considered to be the same as the external. Products should be used only in the
environment for which they are rated.

®  Pollution degree 1. No pollution or only dry, nonconductive pollution occurs.
Products in this category are generally encapsulated, hermetically sealed, or
located in clean rooms.

B Pollution degree 2. Normally only dry, nonconductive pollution occurs.
Occasionally a temporary conductivity that is caused by condensation must
be expected. This location is a typical office/home environment. Temporary
condensation occurs only when the product is out of service.

B Pollution degree 3. Conductive pollution, or dry, nonconductive pollution
that becomes conductive due to condensation. These are sheltered locations
where neither temperature nor humidity is controlled. The area is protected
from direct sunshine, rain, or direct wind.

B Pollution degree 4. Pollution that generates persistent conductivity through
conductive dust, rain, or snow. Typical outdoor locations.

Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location
use only.
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Compliance information

Environmental considerations

This section provides information about the environmental impact of the product.

Product end-of-life =~ Observe the following guidelines when recycling an instrument or component:
handling

Equipment recycling. Production of this equipment required the extraction and
use of natural resources. The equipment may contain substances that could be
harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to
reduce the use of natural resources, we encourage you to recycle this product in
an appropriate system that will ensure that most of the materials are reused or
recycled appropriately.

This symbol indicates that this product complies with the applicable European
Union requirements according to Directives 2002/96/EC and 2006/66/EC

on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Support/Service section of the
Tektronix Web site (www.tek.com).

Restriction of hazardous  This product is classified as an industrial monitoring and control instrument
substances  accessory, and is not required to comply with the substance restrictions of the
recast RoHS Directive 2011/65/EU until July 22, 2017.
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TBX3000A

Overview

This guide introduces the TBX3000A and provides a step by step demonstration
of how to use the product.

Packing list

Please confirm that you have received all the items listed in the packing list:

The TBX300A

4 USB cables

1 power cable

1 DC power adaptor

Get acquainted with the TBX3000A

Main features = TBX3000A is used to connect Tektronix and Keithley products: oscilloscope,
signal generator, digital multimeter, and power supply.

®  Jtis equipped with USB 2.0 ports and RJ45 10/100Mbps Ethernet port

B ]t can be connected to WIFI after installing a USB WIFI dongle
(eg. TEK-USB-WIFI)

® [t is powered by a DC power adaptor (5V/3A)

TekSmartLab User Manual 1



TBX3000A

Appearance

“ N
Lo Pyl
LAN S ) st/ DC POWER
— = DEVICE RESET
T ——

Figure 1: Side view 1 of TBX3000A
One side of TBX3000A has the following connectors, buttons, and indicators:

®  Ethernet LAN port: The TBX3000A is connected to the network through
this port.

m  USB device port: The original code of the product is burned through this port,
which is used by manufacturer only.

B Reset button: If you press this button and hold down to 5 seconds, the SYS
indicator will blink rapidly for 5 seconds, then the default setting (including
password and IP parameters) will be restored.

B DC power socket: Use this connector for the DC power supply that came
with your instrument.

P

\

Figure 2: Side view 2 of TBX3000A

§
T — J
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| S— | S—

{

The figure above shows another side of TBX3000A with six USB 2.0 ports. You
can connect TBX3000A to other instruments by USB cable.
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TBX3000A

TekSmartLab User Manual

The figure below is the top view of the TBX3000A, showing the Tektronix logo
and indicators.

[ 3

(|

e OROINDXS
7

Figure 3: Top view of TBX3000A

m  The first six are USB indicators. If the indicator is on or blinking, it means
some instrument is connected to TBX3000A through a USB port.

®  The one next to the USB indicators is the WIFI indicator:

= Ifit’s not on, it means the USB WIFI dongle is not installed or the WIFI
dongle is not compatible with the instrument.

= If it blinks once at a time, it means the USB WIFI dongle is installed, but
TBX3000A is not connected to the WIFL.

= If it blinks twice at a time, it means the USB WIFI dongle is installed, and
TBX3000A is connected to the WIFL.

B The last indicator is the system indicator (SYS):

= If it blinks rhythmically, it means the power is on and the system is
functioning.

= Ifit’s not on, it means the power is not on or the system is malfunctioning.

= If it blinks unrhythmically, it means the firmware is upgrading.



TBX3000A

The figure below shows the bottom aspect of TBX3000A.
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Figure 4: Bottom view of TBX3000A

The part illustrated as 7 is a socket for USB WIFI dongle like TEK-USB-WIFI.

Configure the TBX3000A

When the TBX3000A is connected to the network, you can configure instrument
parameters. The default IP address for the instrument is 192.168.1.101. Enter the
default address into a web browser, press Enter, and the welcome page shown

below is displayed.

m )| @ nhitp/1922681201

Welcome Page
‘Welcome Page

P~ 0” 2 Welcome

| ngad 13}

Instrument Model:

TBX3000A

Firmware Revision:

200

bl o on Serial Number:

€010625

Set Password LAN Connection Status:

Connected

WIFI Connection Status:

Disconnected

Host Name (FQDN):

Bench1 local.

Figure 5: Welcome page for TBX3000A configuration

The Welcome page shows the firmware version, serial number, LAN connection
status, WIFI connection status, and the hostname of the TBX3000A.
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LAN Configuration  Click LAN Configuration in the navigation bar on the left to show the LAN
Configuration page.

= e =B
[ LAN Configuration x '\
&« C [ [} 192.168.1.101 w2 =
LAN Configuration
Welcome Page
= Hostname: Bench1
LAN Configuration
Description: TBX3000A
Lo SRl TCP/IP Configuration Mode: Manual
Set Password IP Address: 192.168.1.101
Subnet Mask 255.255.255.0
Default Gateway: 192.168.1.1
Connect Status: Connected
Speed: 100Mbs
=5
Teklron/lx"

Figure 6: LAN Configuration

Click Modify to configure the LAN parameters and the host name.

The default LAN configuration values are shown below:

Host Name Bench 1
TCP/IP Configuration Mode Manual

IP Address 192.168.1.101
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.1

TekSmartLab User Manual 5
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WIFI Configuration ~ Click WIFI Configuration in the navigation bar on the left to show the WIFI
Configuration page.

— (=] 2 ot
[ ") WIFI Configuration x ¥
&« ¢ [1192168.1.101 9=
WIFI Configuration
Welcome Page
Hestname: Benchi
LAN Config
Description: TBX3000A
LRl e TCP/IP Configuration Mode: Auto
Set Password IP Address: 169.254 73 87
Subnet Mask: 255.255.0.0
Default Gateway: 192.168.1.1
SSID:
Connect Status: Disconnected
Signal Intensity:
'I'eklmn/ix'-

Figure 7: TBX3000A WIFI Configuration
Click Modify to configure WIFI network parameters.
Click Scan AP to search for the SSID of the WIFI network.

NOTE. The TBX3000A will connect to the WIFI network, only after the USB WIFI
dongle is installed on the instrument.
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Set Password  Click Set Password in the navigation bar on the left to change the password
for the instrument.

Ty —— [P=REEE S
/[ Administration x \_
€& =& € [11921681.101 ¥ =
Administration
‘Welcome Page
LANC e Change Password:
WIFI Configuration
St Parsword [Current Password:
New Password:
[Confirm New Password
Tektronix-

Figure 8: Set Password

You can change the password on this page. The default password is admin.
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TSL3000B installation

TSL3000B installation

Hardware and software requirements for the server

Hardware requirments

Software requirements

Installing TSL3000B

CPU: 2.3 GHz dual-core or higher

Memory: 4 GB DDR3 or higher

Display: Resolution of 1366 by 768 or higher
Storage: 160 GB or higher

Operating system: Win7 Professional, Enterprise, or Ultimate

.Net framework 4.5.2 and Visual C++ 2015 redistributable will be installed
automatically if they are not available on the computer.

Internet Information Service: IIS 6.0 or higher. For installation instructions,
please refer to IIS installation and configuration(See page 27, /1S installation
and configuration.)

Database system: SQL Server 2014 Express or SQL Server 2014 Enterprise.
For installation instructions, please refer to Installing SQL server 2014 espress
(See page 9, Installing SQL server 2014 express.)

Visit www.tek.com, and search for ‘TSL3000B’. Search through the results
and find the latest version of the software. Download and install the software,
following the software installation instructions on screen.

TekSmartLab User Manual
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TSL3000B installation

Installing SQL server 2014 express

Downloading the
installation pack

TekSmartLab User Manual

Visit http://www.microsoft.com/enin/
download/details.aspx?id=42299=rss_alldownloads devresources, and choose
the installation pack consistent with the bit number of your operation system.
For example;

m  For 64-bit Win7, choose ExpressAndTools
64BIT\SQLEXPRWT x64 ENU.exe

®  For 32-bit Win7, choose ExpressAndTools
32BIT\SQLEXPRWT x86 ENU.exe

NOTE. The size of the installation pack is around 800MB.

The installation cannot be carried out if the bit number of the installation pack is
not consistent with your operation system.



http://www.microsoft.com/en-in/download/details.aspx?id=42299&WT.mc_id=rss_alldownloads_devresources
http://www.microsoft.com/en-in/download/details.aspx?id=42299&WT.mc_id=rss_alldownloads_devresources

TSL3000B installation

Installing the software  In this procedure, we use the 64-bit Win7 installation package as the example.
This section explains how to install the database system.

1. Double-click SQLEXPRWT x64 ENU.exe, and choose the directory for
extracted files. The following figure is displayed.

Microsoft SQL Server 2014 Express with Tools ==

Preparing: D:\5ca2536b768603c2ee92dde 2a 7redist\DotMe. .. \NDP40-KB2468871-V2.EXE

Figure 9: Extracting files

You may have to wait up to two minutes while the installer extracts the
TSL3000B installation files. Then the following figure is displayed.

= = ]
13 5QL Server Installaton Centy =
Planning % Mew 5QL Server stand-alone installation or add features to an existing installation
It llati Launch a wizard tc install SQL Server 2014 in a non-clustered environment or to add I
features to an existing SQL Server 2014 instance.
Maintenance |
T ﬁ Upgrade from SQL Server 2005, SQL Server 2008, SQL Server 2008 R2 or SQL Server 2012
ools
Launch a wizard tc upgrade SQL Server 2005, QL Server 2008, SQL Server 2008 R2 or SQL
Resources Server 2012 to SQL Server 2014,
Optiens I
I
I
i
i
I
Microsoft SQL Server2014 i

Figure 10: Installation center
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TSL3000B installation

2. Click New SQL server stand-alone installation or add features to an
existing installation. The following figure is displayed.

License Terms

To install SQL Server 2014, you must accept the Microsoft Software License Terms.

License Terms A~
MICROSOFT SOFTWARE LICENSE TERMS =
Global Rules 3
Microsoft Update MICROSOFT SQL SERVER 2014 EXPRESS
| Product Updafes These license terms are an agreement between Microsoft Corporation (or based on where you
Install Setup Files live, one of its affiliates) and you. Please read them. They apply to the software named above,
Install Rules which includes the media on which you received it, if any. The terms also apply to any Microsoft

e updates,
Feature Rules

Feature Configuration Rules » supplements,

. Feature Selection
I
I
|

Installation Progress

Complete Copy  Print

| [T 1 accept the license terms. I

@] Turn on Customer Experience Improvement Program (“CEIP“) and Error Reporting to help improve the
quality, reliability and performance of Microsoft SQL Server 2014.

See the Microsoft SQL Server 2014 Privacy Statement for more information.

* Microsoft SQL Server 2014 also includes a Visual Studio component that will have CEIP settings turned
off by default. If Visual Studio is installed, this component will use the CEIP settings for Visual Studio.

Figure 11: License terms

3. Select I accept the license terms.
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TSL3000B installation

12

4. Click Next. The program will check whether the files for installation are

correct.

SQL Server 2014 Setup

Install Setup Files

If an update for SQL Server Setup is found and specified te be incluced, the update will be installed.

Global Rules
Microsoft Update
Product Updates
Install Setup Files
Install Rules
Installation Type
License Terms
Feature Selection
Feature Rules
Feature Configuration Rules
Installation Progress

Complete

T —
Task Status |
Scan for product updates Completed
Download Setup files Skipped
Extract Setup files Skipped
Install Setup files Skipped

<Back H Next > H Tz |J

Figure 12: Setup files check
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TSL3000B installation

After verifying the files, the following figure is displayed.

-
5 SQL Server 2014 Setup

b= ) e |

Feature Selection

License Terms

Global Rules

Microsoft Update

Product Updates

Install Setup Files

Install Rules

Feature Selection

Feature Rulzs

Instance Cenfiguration
Server Configuration
Database Engine Configuration
Feature Configuration Rules
Installation Progress

Complete

Select the Express features to install.

Eeatures:

Instance Features|

Database Engine Services
SQL Server Replication
Shared Features
Client Tools Connectivity
Client Tools Backwards Compatibility
Client Tools SDK
Management Tools - Basic
Management Tools - Complete
SQL Client Connectivity SDE
[[] LocalDB
Redistributable Features

Feature description:

The corfiguration and operation of each
instance feature of a SQL Server instance is
isolated from other SQL Server instances, SQL
Server instances can operate side-by-sidleon

Prerequisites for selected features:

Already installed: -
- Windows PowerShell 2.0
Microsoft NET Framework 3.5 2
4 1 +

Select All Unselect All

Disk Space Requirements

Drive C: 2535 MB required, 23218 MB available ~

Instance root directory:
Shared feature directory:

Shared feature directory (x86):

C\Program Files\Microsoft SQL Server\, E
C\Program Files\Microsoft SQL Server. E

C:\Program Files (x86)\Microsoft SQL Server\,

< Back H Nesxt > H Cancel H Help ]
Figure 13: Feature selection
5. Click Select All
6. Click Next. The following figure is displayed.
T - PR

r
T SQL Server 2014 Setup /

Instance Configuration

Specify the name and instance ID for the instance of SQL Server. Instance I becomes part of the installation path

Licenss Terms

Global Rules

Microsoft Update

Product Updates

Install Setup Files

Install Rules

Featurs Selection

Featurs Rules

Instance Configuration
Server Configuration
Database Engne Configuration
Featurs Configuration Rules
Installation Progress

Compete

Named instance:

MSSQLSERVER

Instance I MSSQLSERVER

SQL Server directory:

Installed irstances:

C\Program Files\Microsoft SQL Server\MSSQL12 MSSQLSERVER

Instance Name Instance ID Featurzs

Edition Wersion

e

Next > ” . H Help

Figure 14: Instance configuration

TekSmartLab User Manual
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7. Select Default Instance.

8. Click Next. The following figure is displayed.

6 '
SQL Server 2014 Set — e = B
A SQLserver up
Server Configuration
Specify the service accounts and cellation configuration.
Licensz Terms Service unts | Collatien
Global Rules
5 . 5

Microsoft Update Microsaft recommends that you use a separate account for each SQL Server service.
Product Updates Service Account Mame Password Startup Type
Install Setup Files SQL Server Database tngine NT Service\MSSQLSERVER \Automatic -

Install Rules SQL Server Browser NT AUTHORITV\LOCAL ...

Disabled ¥

Featurz Selection

Featurz Rules

Instance Configuration
Server Configuration
Database Eng ne Configuration
Featurz Configuration Rules
Installation Progress

Complete

<gack || New>

H Cancel ” Help

Figure 15: Server configuration

9. Click Next. The following figure is displayed.

[ o
% SOL Server 2014 Setup ) Fe —a (o e B

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directaries,

License Terms Server Configuration | Data Directories | User Instances | FILESTREAM

Glebal Rules

Microsoft Update Specify the authentication mode and administrators for the Database Engine.
Product Updates Authentication Mode

A= ©® Windows authentication mode

Install Rules

Feature Selection

@ Mixed Mode (SQL Server authentication and Windows aulhanli(aﬁnn)l

Instance Configuration

Enter password: sssanes
Server Configuration

Feature Rules Specify the password for the SQL Server system administrator (sa) account.

Confirm password:  sssssessssssessl l

Database Engine Config
Feature Configuration Rules Specify SQL Server administrators
Installation Progress GLOBALVIchen3 (Ichen3)
Complete

SQL Server administrators
have unrestricted access
to the Database Engine.

Add Current User ] [ Add... l [ Remove ]

[ < Back H Next > ” Forn ” Help

Figure 16: Database engine configuration
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TekSmartLab User Manual

10. For authentication mode, select Mixed Mode.

11. Input the system administrator (sa) password “TekSmartLab2015”.

NOTE. This password is mandatory. Make sure that T, S, and L are all uppercase.

12. Click Next. The following figure is displayed.

)
st sener 20t et B L RS B e

Installation Progress

License Terms

Global Rules P -
Microsoft Update Install_SqlSupport_Cput4_Action : CreateShortcuts. Creating shortcuts
Product Updates

Install Setup Files

Install Rules

Feature Selection

Feature Rules

Instance Configuration

Server Configuration

Database Engine Configuration
Feature Configuration Rules
Installation Progress
Complete

Figure 17: Installation progress

While this figure is being displayed, the database system is being installed.
This typically takes about 10 to 20 minutes to complete.
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When complete, the following figure is displayed.

r
T4 SQL Server 2014 Setup

Pr-— [ o

Complete

License Terms.

Glebal Rules

Microsoft Update

Product Updates

Install Setup Files

Install Rules

Feature Selection

Feature Rules

Instance Configuration
Server Configuration
Database Engine Configuration
Feature Configuration Rules
Installation Progress

Complete

Your SQL Server 2014 installation completed successfully with product updates,

Information about the Setup operstion or possible next steps:

Feature Status
& Management Toals - Complete Succeeded
i Client Tools Connectivity Succeeded
12 Client Tools SDK Succeeded
12 Client Tools Backwards Compatibility Succeeded
Management Tools - Basic Succeeded
17 Natahase Fnaine Services Succeeded 2
Details:

Viewing Product Documentation for SQL Server

Only the components that you use to view and manage the documentation for SQL Server have
been installed. By default, the Help Viewer component uses the online library. After installing
SQL Server, you can use the Help Library Manager component to download documentation to
your local computer. For more information, see Use Microsoft Books Online for SQL Server
<http://go.microsoft. comfwlink/?LinklD=299578:).

Summary log file has been saved to the following location:

C\Program Files\Microsoft SQL Server120\Setup Bootstraphlegh20160607 132748\Summary W-SHPD-

LCHENZ2-1 20160607 132748.6¢

Figure 18: Installation complete

13. Click Close.

The installation of the database system is complete.
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Configuring the database

TekSmartLab User Manual

1.

Select SQL Server 2014 Configuration Manager in the Start menu of
Windows, as shown in the following figure.

R T T

; Microsoft SQL Server 2014

a Download Micraseft SQL Server Cor
L SQL Server 2014 Import and Export C
L SQL Server 2014 Import and Export L
Uz 5QL Server 2014 Management Studic
. Analysis Services

Confioucation Tools
E_E SOL Server 2014 Configuration M
Em SUL server (014 Error and Usage
¥ SQL Server 2014 Installation Cent
S SQL Server 2014 Reporting Servic

Figure 19: Select configuration manager

The path to this link is:

Start >> All Program >> Microsoft SQL Server 2014 >> Configuration Tools
>> SQL Server 2014 Configuration Manager

In the SQL Server Configuration Manager, click SQL Server Network
Configuration >> Protocols for MSSQLSERVER, and then right-click
TCP/IP in the right panel as shown in the following figure.

Depending on the operating system, the SQL Server Network Configuration
link might be (32 bit) or (64 bit).

st o

File Action View Help

L AR ENCRERN 7|

48 SQL Server Configuration Manager (Local) Protocol Name. Status
' %~ Shared Memory  Enabled
¥ Named Pipes Disabled
FTceP Disabled

Figure 20: Enable TCP/IP protocol
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3. Select Enable in the pop-up menu.

The following figure is displayed after you enable TCP/IP.

-
[ Sal Server Cenfiguration Manager
Zile Action View Help

LL AE=iEy
48 SQL server Configuration Manager (Local) Protocol Name Status

£l sl Server Servizes Y SharedMemory  Enabled

4. SQL Server Network Configuration (32bit)

|| » 2 saL Native Client 11.0 Configuration (2bit) e teoed |
= 'R TCP/P Enabled

i 4 8. sqL Serer Network Configuration & —

f 8- Protocols for MSSQLSERVER

I > B SQL Native Client 11.0 Configuration

Figure 21: TCP/IP protocol enabled

4. Click SQL Server Services in the left panel. The following figure is
displayed.

[ SatServer Configurtion Mansger | mm— ) — - | - Elﬂ____ﬂ_j]

File Action View Help
esls0elB004e

48 QL Server Configuration Manager (Local) Name
[ SQL Server Services o
B QL Server Network Configuration (32bit) E -y

> B SQL Native Client 11.0 Configuration (32bit)

4 50L Server Network Cenfiguration
Ef Protocols for MSSQLSERVER

» & SQL Native Client 11.0 Configuration

State Start Mode Log On As Process D
d Other (Boot, Syste..

unning

Other (Boot, Syste...  NT AUTHORITYANE... 0

Figure 22: SQL server services

5. Click SQL Server (MSSQLSERVER) in the right panel.

6. Click

in the toolbar to restart the SQL server service.

7. Close the window.

8. Click Start >> All Programs >> Microsoft SQL Server 2014 >> SQL Server
2014 Management Studio, as shown in the following figure.

1 Microsoft Silverlight
. Microsoft SQL Server 2014
a Download Microsoft SQL Server Cor
~ L SOL Server 2014 Import and Export C
b SOL Server 2014 Import and Export C
;dﬁ- S0L Server 2014 Managerment Studic
. Analysis Services =

. Configuration Tools

. Integration Services

Figure 23: Select SQL server management studio
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10.
11.
12.
13.

In the Connect to Server window, select Database Engine for Server type.
Select the name of the computer for Server name.

Select SQL Server Authentication for Authentication.

Enter sa for Login.

Enter TekSmartL.ab2015 for Password, as shown in the following figure.

Microsoft SQL Server 2014

Server type: lIIat abaze Engzine

Server name: W-SHPD-LCHEN3-1

Authentication: ISQL Server Authentication

Login: sa
Pas=word: bk ok

Remember password

[ Connect ]I Cancel I[ Help JI Optionz »>

Figure 24: Connect to server

14

. Click Connect to log in. The following figure is displayed.

3 [[SSG

Figure 25: Main screen

15

. In the left panel, right-click Database.
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16. Select Restore Database from the popup menu, as shown in the following

figure.

T Wirosot S0 Serve Mgt Siic ™

File Edit Yiew Debug Tools Window ﬂ_ekp

1~ - 5 e | Newauery [t £ 53| 4
Object Explorer v 1 x

Connect> 4 4 = [ 3] 5

= [ W-SHPD-LCHENS-1 (SGL Server 12.0.20

Feslure Fies and Filegroups...

— B3
e e MNew Datanase...

[P |
& 3 Sec Attach...
& [ Sen Restore Database...
& 3 Rep
= L3 Mai

Deploy Deta-tier Application...
Import Data-tier Application...

Start PowerShell

Reports

Refresh

Figure 26: Restore database

17. Enter TSLDatabase next to Database.

18. Select Device.
19. Select “...".

20. Click Add, as shown in the following figure.

s - |l

Sewns
[ |

Etad 1e

Farizs plin
Bl Lo sinie
Feoy gwm Cowporend Troe Govwer Citobay

= ke bk e

Zpei Iy i bavkoy nadin wd its Jmeatiem G pem snvies i

S R— Fils
Bk pain

Figure 27: Specify backup

20
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21. Find the file TSLDatabase.bak in one of the following directories:

TSLDatabse.bak

TSLDatabse.bak

For 64-bit Win7: C:\Program Files (x86)\Tektronix\TekSmartLab\

For 32-bit Win7: C:\Program Files\Tektronix\TekSmartLab\

NOTE. Ifyou are not able to find the file, select All Files next to Files of type,
as shown in the following figure.

S

r = N
[ Locate Backup File - W-SHPD-LCHEN3-1 = ]
Backup File Llocation: C:\Progran Files (x86)\Tektronix\Teks 2y

-3 PELive + [ appdate
{1 9aMailFlugin [dCourselib
{1l Reference hssemblies =
-~ Sogoulnput [dLib
[0 TeanVi ewer Callos
- Tektronix R Report
= ArbExpress CSIHeb
- TekSrartLab )
[H-0 appdata
i 86
3 ConrseLib ~
-3 Doe
-3 Lib
[ Log
-1 Report
#-[ 1 SLieb
- Hbd
=-Ca ¥s8 il
« e | » pe —
File name: TSLDatabaze bak [Backup Files(x baki¥. trai%. Log ﬂ
[ 0K ‘ [ Cancel I

Figure 28: Change file type

22. Click OK after you find the file, and the following figure is displayed.

fowsce
Driane
s 2 it o e ) e
[TV |
Spakily ths b Sals ihd At Liwtion [0 o Saltins ST
Cirdwanon
Datstase ST o Te -
Bt E- —
i ST .
Pattd plan —
Eaghup sty taramore [
Fesow  Vame  Compal = — [ UswHam B
[
s -

Figure 29: Backup file found
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22

23. Select the file using the checkbox in the Restore column, and then click OK.

The following figure is displayed.

Restore plan

Backup sets to restore:

Bl
. Dstsbase  Full W-SHPD-HALW TSLDatsbase 2

2 Restore Database - TSLDstabase e ==
(0 Ready
Selecta page 5 script - |[EyHelp
= Geneal
2 Files. 5
= Flles ource
2 Optiens.
© Database:
@ Device: C:\Program Files (x86)\ TektronoTekSmartLab\TSL Database.bak
Database: T5LDatabase =
Destination
Datobase: TSLDatabase -
Restoreto: The last backup taken (Manday, May 23, 2016 12:27:41 PM) Timeli

on Pt LoN

102000000074500036 1020000000761

Connection
3 W-SHPD-LCHEN3-L (sa]

Verify Backup Media

OK H Cancel I Help J

Figure 30: Select the most recent database

24. Click OK to complete the configuration and a confirmation message is
displayed, as shown in the following figure.

F
Microsoft SQL Server Management Studic

[

|0I Database T5LDatabase' restored successfully.

Figure 31: Database configuration complete

NOTE. If you had installed SQL Server 2008 R2 Express and restored the
TSLDatabase.bak before, select Options and then select Overwrite the existing
database (WITH REPLACE) as below before restoring the file.
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42 Restore Database -

Connection
B WSHPD-LCHEN3 1 [sa]

€ No backupset selected tobe estore.

S scipt - | Hep

Overite the xising database (WITH REPLACE)
71 Preserve the replication settings (WITH KEEP_REPLICATION)
] Restrict access to the restored database (WITH RESTRICTED_USER)

Recovery state:

Standby file:

Tail-Log backup
] Take tail-I

Lea
O

Backup file:

Servr conections
7] Close eiting connections o destinaion databaze

Prompt
) Prompt befor restorng each backup

Ready

®

Figure 32: Overwrite the existing database
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24

Adding Inbound Rules

1.

3.

Open the firewall setting screen by navigating to Start >> Control Panel >>
System and Security >> Windows Firewall >> Advanced Setting’.

Double click Inbound Rules and then right-click it to display the pop-up

menu.

Select New Rule..., as shown in the following figure.

o ox
i e et
o i G Puble  Enblud vide | Pougren  LocalAdduen Rumate Ak P 2 || inbound Bules -
T HR0GR. Ary g T | e
== o U e .
Views g o | mrey s v
ay T '
Retrch g L f
Eaput Lt g 1
pe i 1
g T
o v
Ay v
e T
Ay 1
g a
G License Sernce Merts Ay T
s Sarvize Maragarnent sy T
- u
g u
g u
- 1
. a
oy 2
8 Microsoft Offce Dutiok g u
@ Hirer e I
el o Ay i
@ vistuerang - kcno Hequen any ¥
@ biehvcrs e ¥
@ e any X
@ any f
8 Mizhucrang - Inestomp Fegquest ICKIE. any [
an o Wb Servas e 1
g i
g 1
Ay v
s v,
< s . 5
Figure 33: Create new rule
4. Select Port, and click Next.
& New Inbound Rule Wizard X
Rule Type
Select the type of firewall rule to create.
Steps:
» Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action O Program
@ Profile Rule that controls connections for a program.
@ Name ® Port
Rule that controls connections for a TCP or UDP port
() Predefined:
AllJoyn Router
Rule that controls connections for 8 Windows experience
) Custom
Custom rule.
< Back Next > Cancel

Figure 34: Select port
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5. Select TCP, select special local ports and input 1433, then click Next..

WP New Inbound Rule Wiz X
Protocol and Ports

Specify the protocols and ports to which this rule applies.

Steps:

o e Type Does this e apply to TCP or LIDP?

& Protocol and Pors @® TP

@ Acion O upp

@ Frofie

N

@ Mame Does this rule apply to alllocal ports or specific local ports?
O Alllocal ports
@® Specific local ports: 1433

Example: 80, 443, 5000-5010

<Back Next > Cancel

Figure 35: Allow the connection

6. Select all the options and click Next.

@ New Inbound Rule Wizard ®
Profile
‘Specify the profiles for which this rule applies.

Steps:

@ FRule Type When does this ule apply?

@ Protocol and Ports

@ Action Domain
& Profile Applies when 2 computer is connected to ts corporate domain.
@ Name Private
Applies when a computer is connected to @ private network location. such as 2 home
or work place
Public

Applies when 3 computer is comnected to @ public network location.

< Back Next > Cancel

Figure 36: Profile
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7. . Input a Name, for example TSLSQL, and click Finish.

B New Inbound Rule Wizard

Name
Specify the name and desaription of this rule.

Steps:
@ Rule Type

@ Protocol and Ports
@ Action

@ Profile

@ Name

Name
[Tsisadf

Description (optional)

<Back Cancel

Figure 37: Input name
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IIS installation and configuration
Installing IIS in Win7 1.

Click Start >> Control Panel >> Programs >> Turn Windows features on or

off, and then select Internet Information Services as shown in the following

figure.

.
ontrol Panel » Programs

OO-& G e

-[6][ =

Control Panel Home

lI:J Programs and Featue
K4 5 < W 5 " s <
e S Uninstall a program ew installed updates
Run pregrams made for preVioUe veTsroms TS| How to install a pregram
Network and Internet T e
o olE] = )
Hardware and Sound ‘@ Default Programs &l SR
& Change default setting] i
* Programs Setyour default progra. TUrn Windows features on or off (Z]
User Accounts Desktop Gadgets|| T2 fm a feature on, select s check box. To fum a feature off, dear s chedk box. A filed box means that oy part
of the feature is turned on.

Appearance and

Add gadgets to the de§
Personalization

Restore deskiop gadgel
Clock, Language, and Region

Ease of Access 't FreeFall Data Prof

&,| Java (32-bit)

[

@ ]} Games
[T] }. Indexing Service
[7] . Internet Explorer 8

= Internet Information Services
[] | FIP Server
Web Management Tools
= (M) |, World Wide Web Services
=] Application Development Features

JNET Extensibility
Bk asp

ASP.NET

[<lcid

ISAPI Extensions
ISAPT Filters
Server-Side Includes

Common HTTP Features
. Health and Disgnostics
. Performance Features
Security

T 11, TNtermnet InTormanon Ser Vices NS tanle et
Media Features

| Microsoft .NET Framework 3.5.1

| Microsoft Message Queue (MSMQ) Server
Print and Document Services
Remote Differential Compression
Remote Server Administration Tools

| RIP Listener

| Services for NFS

HEE®

]

ID0EES DN~

2]

Core

i}

Figure 38: Select internet information services

NOTE. If you are installing IIS for the first time, make sure that you follow the

instructions above.

2. Browse to World Wide Web Services >> Application Development Features,
and then select the following:

NET Extensibility
= ASPNET

= CGI

= ISAP Extensions
= ISAP Filters

= Server-Side Includes

TekSmartLab User Manual
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3. Browse to World Wide Web Services >> Common HTTP Features, and select
the following

= Default Document
= Directory Browsing
= HTTP Errors

= HTTP Redirection
= Static Content

4. Click OK.

NOTE. Make sure that Web Management Tools is selected by default.

After a few minutes, the installation will finish.

Installing IS for web server 1. Open the Internet Information Services (IIS) Manager on your computer
one of the following two ways:

= Click Start, and enter IIS in the search box. Then open the Internet
Information Services (IIS) Manager from the search results.

= Right-click Computer, and then select Manage. You can find Internet
Information Services (IIS) Manager under Services and Applications,
as shown in the following figure.

EET open

[.'_'1 Manage

& TortoiseSVN v

Map network drive...
Disconnect network drive...

Create shortout
Delete
Rename

Properties

Figure 39: Open internet information services manager
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2. Collapse the items in the left panel.
3. Under Sites, select Default Web Site.

4. Click Stop under Manage Web Site in the right panel, as shown in the
following figure.

€= Internet Information Services (IT5) Manager = 2 |
.
@ ()] [€ » wsHPDBYANL » Sites » DefaultViebSite » | & = 5@ -
Fie View Help
- Default Web Site Home
[~} 4 Explore
4 83 W-SHPD-BYAN1 (GLOBAL byan1) = Edit Permissions. ..
2 12} Application Fools Filter: ~ G0 ~ Ghshow Al | Groupby: Area ~ -
& Edit Site
4 ASP.NET
™45 Default Web Site 3 — - _ Bindings...
= > A I & 7 -]
"% Z 0 B4 éu;_) = ab) sic Settings...
NET NET {NET Error NET MNETProfle  .METRoles .METTrust  .NETUsers  Appication  Connection 2
Authorizati...  Compilation Pages  Globalization Levels Settings Strings
View Virtual Directories
¥ B oL =
| (W =
Machine Key ~Fagesand  Providers  Session State SMTP E-mail -
Controls
15
l : =dl ¢ U =
;Qu!i “‘% @ i = = o
Authenticaton  CGI Compression Default Directory ~ ErrorPages  Handler HTTP ISAPIFiters  Logging -
Document  Browsing Mappings Respo... Advanced Settings...
s Configure
. o & nfig
jj— <=} }f = o= Limits...
MIMETypes  Modules Output Request S5l Settings @ e
Caching Filtering
Oriine Help
Management
Configuration
Editor
| =7 Features view || Content view
Ready LE|

Figure 40: Internet Information Services (IIS) manager
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5. Right-click Sites and select Add Web Site..., as shown in the following
figure.

@5 Internet Information Services (T15) Manager =6 ]
@_@ ‘EbW-SHFD-EYANl b Sites » “\ fa @ -~
Fie View Help

Connections

= 0‘3 Sites

Actions
@ Add web Site...
49 WSHPD-BYAN1 (GLOBAL\byan1) ) Set Web Site Defaults...
"L Applcation Fools Filter: - G - g Show Al | Groupby: No Grouping - ®
4 ] Sites|— — ‘ D Status Binding Path g
Add Web Site... ir
B L =7 WebSite 1 Stopped (... %150 (hitp) SystemDrive %linetpublmroot Orinchey
i Refresh
{75 Switch to Content View

| =] Features vizw |2 Content View

B L6 Zlalaa e
Figure 41: Add a web site

TekSmartLab User Manual



TSL3000B installation

6. Enter SLWeb under Site name.

7. Under Physical Path, select one of the two directories for the SLWeb file.
= For 64-bit: C:\Program Files (x86)\Tektronix\TekSmartLab\SLWeb
= For 32-bit: C:\Program Files\Tektronix\TekSmartLab\SLWeb

8. Click OK, as shown in the following figure, to finish.

-

2dd Web Site (2] = |

Site name:
Centent Directory
Fhysical path:
<rogram Files\ektreniA TekSmartLaE\SLWED > | ., |

Fass-through authentication

l Connect as... ] ’Te;t Settings... ]

Binding
Type: IP address: Porz
http | All Unassigned - &0
Host name:

Example: www.contosa.com or merketing.contose.com

[7] Start Web site immediately

[ ok || concel

h

Figure 42: Select the SLWeb file
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Configuring ASPNET 4.0 1. Open Internet Information Services (IIS) Manager as described before.

2. Select the server name in the left panel (highlighted in the following figure).

" Internet Information Services (IIS) Manager 1= x|
@_@ [Gj + VW-SHPDBYANL * J “| T @ -

Fle View Hep

[Comections @3 wsHPD-BYANL Home lAcions

| Manage Server

e ———
= e o b § 2
L T R ,. by Filter: ~ (G0 - Gshow Al |Groupby: Area YEI- < Restart
P Start
Sites ASPNET e
% Defa.it Web Site : N . ~ ] St
(- SLweb = > i q = it? = )
i ¥ A By = == View Applicaten Poals
2 = e L= = [at] [? : ] e
NET NET .NET Errar NET NET Trust Application Connection ~ Machine Key  Pages and Provders Mebe—
Autharizati...  Compilation Pages Globalization Levels Settings Strings Controls Change .NET Framework Version

L = o
=| Online Help

Session State  SMTP E-mail

€ &

Authentication CGI Compression Default Directory  Error Pages FastCGl Handler H5APT znd CGIE
Document Browsing Settings Mappings oo\ Restrictions ;
15 i I!;&H e o= (2
& = & ifﬁ o= Leak ity
ISAPIFiters  Logging MIME Types  Modules Output Request Server Worker
Caching Filtering Certificates  Processes
Management
B &
1=
Configuration Feature Shared
Editor Delegation  Configuration

[ Features View |/ Content View

Ready %

Figure 43: IS manager
3. Double-click ISAPI and GGI Restrictions in the middle panel.
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4. Right-click the two ASP.NET 4.0 entries to change the restriction to be
Allowed, as shown in the following figure.

‘E Internet Information Services (IIS) Manager
@@‘3\ [y warppavan: »

File View Help

8 [=] ]
FEEYCE

| Gigl ISAPI and CGI Restrictions
| ¥

Add...
=} .Gj W-SHPD-BYAN1 (GLOBAL \byan1)
-2 Application Pools Use this feature to spedfy the ISAPI and CGI extensions that can run on the Web server, Allow
=] Edit...
=[] sites Groupby: Mo Grouping <
Default Web Site - — K Remove
- Description = | Restriction | Path
SLweb
ASP.NET v2.0.50727 Allowed

Allowed
Mot Allowed
Mot Allowed

4]

Sawindir ¥o\Microsoft. NET\Framework64\w 2.0, 5072 aspnet_isapi. di
Sawindir ¥o\Microsoft. NET\Framework\v 2,0, 50727 \aspret_isal
nanft MET\Er:

Edit Feature Settings...
/ @ rep

il
Sworka4\y4.0. 30319 \aspnet_isapi.c Online Help

Add...

Allow

Edit...

Remave

Edit Feature Settings...
Help

Online Help LI

| /| Features View |/ - Content View

Configuration: localhost’ applicationHost. config

Figure 44: Allow ASP .NET 4.0

%

After you’ve changed the status of the two entries, the following figure is

displayed.

“E Internet Information Services (IIS) Manager
@ © [ € » wsosran: »

Fle View Help

| ii‘;l ISAPI and CGI Restrictions
L
E‘...Gj W-SHPD-BYAN1 (GLOBAL \byan 1)
2% Application Pools
Sites

Use this feature to spedfy the ISAFT and CGI extensions that can run on the Web server.

Group by: Mo Grouping <
Default wWeb Site - —
@ sLweb Desaription _+ [ Restriction | Path
{ASP.NET v2.0.50727 Allowed Sewindir %\Microsoft. NET\Framework64\y 2.0. 50727 \sspnet_isapi.dl

A5R.NET v4.0,30319
ASP.MET v4.0,30319

Allowed

Figure 45: ASP .NET 4.0 allowed

TekSmartLab User Manual

Sewindir e \Microsoft. MET \Frameworkv 2.0. 50727 \aspnet_isapi.dll
Ci\WindowsMicrosoft.NET\Framewarkv4.0,30319\aspnet_isapi.di
Ci\WindowsMicrosoft.NET\Framewarks4w4.0.30319\aspnet_isapi.dll
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‘-'E Internet Information Services (IIS) Manager

=[Ol x|
66) [‘53 } W-SPD-BYANL b & @ -
Ele View Help
| @il ISAPI and CGI Restrictions =
ks
=85 W-SHPD-BYAN1 (GLOBAL n .
d % Applicati P( ) \byang) Use this feature to spedify the ISAPI and CGI extensions that can run on the Web server, Edit Feature Settings...
e .pp\ca on Pools
B8] Sites Group by: Mo Grouping - @ Help
[#-4a) Default Web Site Online Help
% SLureb Description » | Restriction | Path
ASP.NET v2.0.50727 Allowed Sawindir Y \Microsoft.MET Framework64'y 2.0, 50727 \aspnet_isapi.dll

ASP.NET w2.0.50727 Allowed Sewindir Yo \WMicrosoft. NET Framework v 2.0, 50727 \aspnet_isapi.dll

4 |
Ermm ] cortven

Configuration: ‘localhost’ applicationHost.config

&

Figure 46: ASP .NET v4.0 not found

34

NOTE. Under some conditions, you may not be able to find ASP.NET v4.0, as
shown in the following figure.

In this case, you can solve the problem by using a DOS command (as
administrator).

a. Under Start >> All Programs >>Accessories, right-click Command
Prompt.

b. Select Run as administrator.
c. Enter one of the following commands in the window:
= For 64-bit Win7:

C:\Windows\Microsoft. NET\Framework64\v4.0.30319\aspnet_regiis.exe —i
= For 32-bit Win7:

C:\Windows\Microsoft. NET\Framework\v4.0.30319\aspnet_regiis.exe —i

You can also copy and paste the command in the window, as shown in the
following
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Administrator: Command Prompt

icrosoft Windows [Version 6.1.76811]
Copyright (c> 2809 Microzoft Corporation. All rights reserved.

C:“\WINDOWS \system32)>

Select All
Scroll
Find...

Figure 47: Paste command by right key

After you enter the command, the following figure is displayed.

Administrator: Command Prompt

Microsoft Windows [Version 6.1.76811]
Copyright (c> 2809 Microsoft Corporation. All rights reserved.

C:SWINDOWS ~system32>C:“Windows "Microsof t .MNET “Frameworkb4 w4 . 8.38317vaspnet_regii)
s.exe —1

Figure 48: Command window after entering the command
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Press Enter to run the command, the following figure is displayed.

Microsoft Windows [Version 6.1.76611
Copyright <(c?> 2889 Microsoft Corporation. All rights reserved.

C:SWINDOWS Nsystemn32 >C: “Windows \Microsoft .NET “Framewvorkb64 w4.8.30317vaspnet_regii)
s.exe —1

Microsoft (R> ASP.NET RegllI§ version 4.8.38319.1792%

Administration utility to install and wuninstall ASP.HET on the local machine.
Copyright (C> Microsoft Corporation. All rights reserved.

Start installing ASP.NET <{4.8.38319.17929%9>.

Finished installing ASP.MET <(4.0.30319.17929>.

C:“\WINDOWS\system32>

Figure 49: Result of the command running

As shown in the figure, ASP.NET v4.0 is installed. You should now be able to
configure ASP.NET v4.0 according to the procedures described in this section.
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Configuring ASP.Net State 1.

Server

the following figure.

On the desktop, right-click Computer.

2. Select Manage. The Computer Management screen is displayed, as shown in

-ioix]
File Acton View Help
e 2@l qo]@m s euon
w Computer Management (Local
B [
& (D Task Scheduler ASP.NET State Service Name = | Description | Statws | StartupType | logonas |
8 @ Event Viewer .+ Application Layer Gateway Service Provides s. . Manual Local Service
@ @] SharedFoders Start the service S Applic Mapag, e v . stem
H _-&\ LUc:IjUsErs and Groups — e
[ (%) Performance :
% Device Manager Description: - ) . Tocal System Hore Actions '
B 2 storage Provides support for out-of-process 4 Ea@round Inbel!lgentTransfer ... Transfersf.. Started Automat!c {D.. Local System
29 Disk Management sess?on .stabes for ASP.MET, If this - baidupcsuiteservice.exe Started Automatic Local System
B Services and Appiications service is stopped, out-of-proczss _ £, Base Filtering Engine The Base F .. Started Automatic Local Service
- ssmation Sery | FEIHEsts ";‘" nto‘tse pr°cess?d'};ﬁ“s ., BDHY Service BEYTE.,.  Started Automatic Local System
Zig;éi;sd:pzns U’j:‘f;\;r;r;’st;il ., BDKVRTP Serviee IAARRIA. Automatic Local System
=0 T CoTTo 4 BDMRTP Service BERT. Automatic Local System
B 5QL Server Configuration 4 BDSGRTP Service BEEZE. Automatic Local System
£+ BitLocker Drive Encryption Service  BDESVC ho .. Manual Local System
f+;Block Level Backup Engine Service  The WBEN... Manual Local System
{+;Bluetooth Suppert Service The Blueto... Started Manual Local Service
£+ Bonjour Service Enables ha... Started Automatic Local System
% BranchCache This servic... Manual Network 5...
‘. Certificate Propagation Copies use... Started Automatic Local System
4 Cisco AnyConnect Secure Mabilit... Cisco AnyC... Started Automatic Local System
4 CNG Key Isolation The CNG k...  Started Manual Local System
£+, COM+ Event System Supports 5. Started Automatic Local Service
4, COM+ System Application Manages t... Started Automatic Local System
£ Computer Browser Maintains a... Started Manual Local System
4 ConfigMgr Task Sequence Agent  ConfigMar ... Manual Local System
f+ Configuration Manager Remote .. Provides th... Started Automatic (0. Local System
£+ Credential Manager Provides s. . Manual Local System
‘. Credential Vault Host Contral Ser... HostContr... Started Automatic Local System
£, Credential Vault Host Storage Host Stora...  Started Automatic Local System
4 Cryptographic Services Provides fo... Started Automatic Metwork 5...
£, DCOM Server Process Launcher The DCOM... Started Automatic Local System
S Defary Started Automatic Local System
£+ Desktop Window Manager Sessio... ProvidesD... Started Automatic Local System
5+ DHCP Client Registers a... Started Automatic Local Service ﬂ
4 | 21N Extended A Standard Vi
|

Figure 50: Computer management

3. Select Computer Management (Local) >> Services and Applications >>
Services.

4. Select ASP.Net State Service in the right panel to confirm that the status is
‘Started’ and Startup Type is ‘Automatic’.

If not, change them by following these steps:
1. Right-click ASP.Net State Service.

2. Select Start or Restart.

3. Double-click ASP.Net State Service.

TekSmartLab User Manual 37



TSL3000B installation

File Action View Help

4. Change the Startup Type to Automatic, as shown in the following figure.

ﬂcumputer Management

= [=] 1]

e e T

= m System Tools
@ Task Scheduler
@ Event Viewer
[z2| Shared Folders

@ Performance
24 Device Manager
Bl &5 Storage
=¥ Disk Management
=

[l f4 Services and Applications

(. Services

KN

A Computer Management (Local)

| Local Users and Groups

‘ﬂ) Internet Information Serv

{ WMI Control
SQL Server Configuration

|

ASP.NET State Service

Start the service

Description:

Provides support for out-of-process
session states for ASP.NET. If this
service is stopped, out-of-process
requests will not be processed, If this
service is disabled, any services that
explictly depend on it will fall to start,

Name ~ | Description | Status | Startup Type | Log On As
“+ Application Host Helper Service Provides a...  Started Automatic Local System
. Application Identity Determines. .. Manual Local Service
“+ Application Information Fadiitates ...  Started Manual Local System
4 Application Layer Gateway Service Provides s... Manual Local Service
£, Application Management Processes i... Manual Local System
‘3 ASP.NET State Service Provides s... Manual Metwork S...
£ Audio Service Manages a... Started Automatic Local System
5T St ServiceProperties LocalComputer) i
o baidupcsui m
(.. Base Filter General I Log On I Remvew| DePe"de"dE-"I e
£, BDHY Sery m
£, BDKVRTP ¢ Service name: aspnet_state -
CLBDMRTPS  Displayname:  ASP.NET State Service m
.¢ e - Provides support for out-of process session stznafor;l o
- Ailloder 1 Bk }hrso;NEl'. [ this service is stopped, out-of process i
G Block Leve LI m
"\ Bkl Path to executable: =
o Boniour Se oo INDOWS \Microsoft NET\Framework64\v4.0.30319\aspret_state exe | ™
4 BranchCac B
: Certificate Startup type: m
4, Cisco Anyt m
CiCNGKeyl — Helpme configurs service startup options. m
£, COM+ Eve re
(;COM+Sys  Serviceststus:  Stopped m
L, Computer m
£ Configmgr Start | Stop | Pause Resumne -
i Configurat You can specify the start parameters that apply when you start the service .
£ Credential From here. m
4 Credential m
i Credential |~ Start parameters: I m
£ Cryptogra .
£}, 0C0M Ser m |

Extended A Standard /

Cancel

More Actions 3

Figure 51: Configure ASP .Net State Service
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5. Click OK to complete the setting.

6. Close the Computer Management screen.
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Windows firewall
configuration

You can open the firewall setting screen by navigating to Start >> Control Panel
>> System and Security >> Windows Firewall >> Advanced Setting’.

Adding inbound rules.

1. Double click Inbound Rules and then right-click it to display the pop-up

menu.

2. Select New Rule..., as shown in the following figure.

=
File Action View Help
===
ws Firewal with Advanced S BTna LT =] | i
pone | ot =
O?Zg::; - WLLUSERSPROFILE %6 \Application Data\Input ... Daomain -z New Rule...
‘; Moniarg = lALLUSERSPROFILE % \Application Data\Input ... Domain ~ Yes Allow )
Fiter by State  » PR OGRAMFILES % \Products\Input Processor. . Domain ~ Yes Allow 7 Filter by Profle 4
Fiter by Group lPROGRAMFILES %\Products\Input Processor .. Domain ~ Yes Allow T Filter by State »
) POECDDA Public Yes Allow
B ronon Publiz  Yes Allow ' Filter by Group ’
Refresh B0 £ODDE UDP Port Publz  Yes Allow View >
Export List.... -Zip File Manager Domain ~ Yes Allow 3 Refresh
Help -Zip File Manager Domain ~ Yes Allow Ly Relres
—=—————————pwrHgilent Communications Fabric Al ‘es Allow |i= ExportList...
@Agilenﬂ:onnecﬁonExpert All Yes Allow Help
@ba\dubrowser.exe Domain ~ Yes Allow
@ba\dubrowser.exe Publiz ‘es Allow
baidubrowser.exe Domain  Yes Allow
baidubrowser.exe Publiz es Allow
@ba\duhmwser.exe Privete  Yes Allow
baidubrowser.exe Privete  Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
@BDAIaddlnAsslsmnt Publiz Yes Allow
@BDAIaddinAssismnt Publiz Yes Allow
@BDAIEddinAssismnt Publiz ‘es Allow
BDAppUpdater Publiz Y3 Allow
@BDAppUpdab&r Publiz Yeg Allow
@bduashreport.exe Publiz ‘fes Allow
bdcrashreport.exe Publiz ‘fes Allow
qbduashreport.exe Domain  ‘Yes A\Icw_ILI
4| | e | »
[Mew Rue. .. [

Figure 52: Add inbound rules
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3. Select Port, and then click Next, as shown in the following figure.

* New Inbound Rule Wizard

Rule Type
Select the type of firewall rule to create.

@ Protocol and Ports
@ Action
@ Profile
@ Name

Figure 53: New inbound rule wizard
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Select TCP.

Select Specific Local ports.
Enter 80 next to Specific Local ports.
. Click Next.

NS s

* New Inbound Rule Wizard x|
Protocol and Ports

Specify the protozols and ports to which this rule applies.

Steps:

& Rule Type Does this nule apply ta TCP or UDP?
« Protocol and Ports @

@ Action DP

@ Profile

@ MName

Leam more asout protocol and ports

<gack || Mea> Cancel

Figure 54: Protocol and ports
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8. Select Allow the connection, and then click Next.

* New Inbound Rule Wizard
Action
Specify the action to be taken when a connection matches the conditions specified in the rule.

@ FRule Type
@ Protocol and Ports

@ Profile
@ Name

Figure 55: Action
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9. Select all three checkboxes and click Next, as shown in the following figure.

* New Inbound Rule Wizard

Profile
Specify the profiles for which this rule applies.

Figure 56: Profile
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10. Enter Web under Name.

11. Click Finish, as shown in the following figure.

*' New Inbound Rule Wizard =0

Name

Specify the name and description of this rule.

Steps:
@ Rule Type
@ Protocol and Ports
@ Action
@ Profils oo
|Web
@ Name
Description {optional):

< Back

[ Ausn ] canece

Figure 57: Name

After you click Finish, the following figure is displayed.

* Windows Firewall with Advanced Security

Fie Aczon lizw  dzh

#37mle R

o :
£ utbo_rd wes
E-! Correrton Sec.rtyRules — , = .

Fipr— AL T “ By
@musmwaﬂfn\mﬂan:r Datalinpr... Jowan a3 thy o . hny
@!&FRDS{WFJLES%EI:M‘JM{ YRS, Jan  Ya3 tha Mo . Ay
@V.FRDS:LO.I"'FJLEE‘,’{Fr:dn‘erl b i=0= nwan  Yas i o . Ay
[V e v tha Mo .y
@EC.E’UDE';'. E T thn Mo . Ay
@cZC.‘E'UDﬂl UDF Pt bl Yas LU, ] Any
@?—3; File Yanager wen Y= sha Mo . Aoy
(01750 e vanacer Tewan ¥az tha M e

Figure 58: Inbound rules added
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Adding outbound rules. Double-click Outbound Rules and right-click it again.

Repeat the steps for adding inbound rules to add outbound rules. The following
figure indicates that you have successfully added outbound rules.

* Windows Firewall with Advanced Seauity

Fie Acir view Hzp

&9 iE= BT

; Winzows Firendl si~ Advanced S EOTTURET 2

i3 Inzourd 5 : e o
K Cornzcton Searty 2ls <%
‘21 Porito-ng @Cﬂ'f Metworang - T TR T

o= Hetnorang - Packet Tao 3ig (ICHPE- Coman  Yer
@Co'z Metwordng - Parzmeter roben (ICVP... Coman  “es
@002 Netsmoreing -Time Evczeded (ICPU6-... Coan  Yes
[ e Al Yes
@hinon Al ves
@Im\:w A &g
@Iri-\\:w A “es
@Netmlhrg -Cestnztizn Jrreachzble (IOVP.., Coman  “eg
@Netmlhrg - Parzmete- roben [IOVPy4-Cut) Coman  Yes
@Nel:.‘.'nlhrg - Rediert (JOPeCut) Coman  Yes

Figure 59: Outbound rules added

Close all the windows once you are finished.
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Testing the web server 1. Open Internet Information Service (IIS) Manager as described before.

2. Select Application Pools in the left panel, as shown in the following figure.

"E Internet Information Services (115) Manager

=[] x|
@g‘) [;ﬁ » W-SHPDBYANL » Application Pools |88~ B @ - I
Fle View Help

2 | 0‘% Application Pools

i; Add Application Poal...
E] BAL\byan1 e |
4 : byl This page lets you view and manage the list of application pools o the server, Application pools are associated with worker processes, cantain ane or mare S A
E| ; applications, and provide isolation among different applications. Application Pool Tasks
E-48) Default Web Site Filter: - [fico ~ (Fyshow Al | Groupby: No Grouping - P Start
@ suneb Name * Status | .NET Frame... | Managed Pipeli... | Identity | Applications | B stop
I ASP.NET v4.0 Started  v4.0 Integrated ApplicationPoollden... 0 2 Recyde...
(5} ASP.NET v4.0 Classic Started V4.0 Classic ApplicationPoollden... 0 Fdit Application Pool
) Classic .NET AppPocl Started  v4.0 Classic ApplicationPooliden... 0 Hoa it
) Defaultapppopl : - G asic Settings...
@5_—: Started w40 Classic ApplicationPoollden... 1 Recydling...
e - T Advanced Settings...
Rename
. K Remove
[Lwen
NET Framework version: Ve Applcaiens
[ MET Framework v4.0.30318 4| @ rep
Managed pipeline mode: Odgeten

Classic he

¥ start application pacl immediately

o ] cona |

Ready

b

Figure 60: Application pools

3. Confirm that the parameters of SLWeb in the right panel are correct:

The version of NET Framework should be 4.0 (or a version consistent
with what is installed).

Managed pipeline mode should be Classic.

If the parameters are something else, you can double-click the entry to
modify them.
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4. Click SLWeb in the left panel under Sites.

5. Click Browse*:80 (http) in the right panel, as shown in the following figure.

E Internet Information Services (IIS) Manager — =] x|
@@ [@ v wepopvant v Sies v slwed » | & <l |®"

Ele view Help

[comections [Acions ]
0 SLWeb Home

& | £ Explore

=95 W-SHPD-BYAN1 (GLOBAL byan1) Edit Permissions. ..
(22 Applcaton Pools Filter: - B8Go ~ ghshow All | Groupby: Area
[=-[8] Sites ASP.NET Edit Site
- P o ) ; _ Bindings...
= NS . r_' 9 f‘ il? = Basic Settings. ..
3 ¥ [ ¢ E 9 - W 5 e sovee LU
NET NET .NET Error MNET NET Profile MET Trust Application Connection  Machine Key Pages and View Applications

Authorizati...  Compilation Pages Globalization Levels Settings Strings Controls View Virtual Directories

g; @I Manage Web Site (o)

-
Session State  SMTP E-mail 2 Restart
P Start
B stop

Browse Web Site

d @ 9 o B @ & ¢ &

Advanced Settings...

tEy

Authentication cal Compression  Default Directory  Error Pages Handler ISAPI Filters Logging
Document Browsing Mappings Re Configure
[ Limits. ..
= oM o 2§ v
4=l J @ Help
MIME Types Modules Output Request 551 Settings
Caching Filtering Odigetes)
Management
Configuration
Editor

| = Features view |/ Content View

Ready

4

Figure 61: SLWeb home
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Windows will automatically open Internet Explorer to http://localhost/. You can
also enter http://localhost/ or http://127.0.0.1/ in the address box of your Web
browser to visit the web page.

The following figure is the web page displayed.

aan P
e _13 http://localhost/ p;x D localhost

Bench:

Course Name: Scope Tutg Mesge from webpage B
Exersise: Rise and fall tim /U, Plesse input bench numsr!
Student Name:

Student ID:

[/Remember me
Scope Snapshot

Figure 62: TekSmartLab web page

This web page indicates that the TekSmartLab web server works fine. (You can
ignore the caution message in the figure above. When you visit the web page
using a QR code, you will not see this message.)

If you are not able to visit the web page, please refer to IIS installation and
configuration (See page 27, I1S installation and configuration.) and confirm that
IIS is properly configured.
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General information
Home page  The TSL3000B home page is shown as in the following figure.

Teltronix TekSmarilab™ Home Setting Administrator Aboul

TekSmartLab

+ Instructor Tektronix = @} %‘

Saved Config Exercise Material
Course  scope tutorial

Exercise  Rise and fall time meas ~ Configure

Inst t
Report Template st

Total Instruments
Normal
Error

Disconnected Test Report

Figure 63: Home page
1. The menu bar: Menus allowing you to configure the software.

2. Course and exercise information: Controls to create and configure the courses
and exercises in this area, as well as other related settings.

3. Configure instruments: Configure the instruments in batch by clicking this
area.

4. Test report: View the test report submitted by students by clicking this area.

5. Lab information: Monitor and modify the parameters of instruments on
certain bench by clicking this area. Displays the bench status and instrument
status in the lab.
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Menu bar  Click Home on the menu bar to return to the main page.

Change language. Click Setting -> Language on the menu bar to change the
software language, as shown in the following figure.

Tektronix TekSmarilab™ Home Setting Administrator About
Language > Chinese
Bench/Lab Layout Config English
General Information wrtLab
Firmware/Courseware Update

>

__/

+ Instructor Tektronix ﬁ@ ==

Saved Config Exercise Material

Course Scope tutorial

Exercise  Rise and fall time meas ~ Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected Test Report

Figure 64: Change language

Lab general information. Click Setting -> General Information on the menu bar
to change the lab general information.

Telitronix TekSmartlab™ Home Setting Administrator About
Language
Bench/Lab Layout Config
General Information wrtLab
Firmware/Courseware Update

# Instructor Tektronix

Saved Config Exercise Material
Course Scope tutorial

Exercise  Rise and fall time meas ~ e — Configure

Instrument
Report Template

Total Instruments
Normal

Ermor

Disconnected Test Report

Figure 65: General information
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The following figure is displayed after you click General Information. You can
change the lab name in the upper part of the page.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information
Lab Information

Lab Name TekSmartLab

QR Code Generation QR Code Print Preview

Bench1

Server IP =
Single Bench NO.
Batch

Width(Urit mm)

Comments

hitp://134.64.230.81/login.aspx?deskid=1

Print

Figure 66: Edit general information

Change the password. Click Administrator -> Change Password on the menu
bar to change the password, and the following dialog box is displayed.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

=+ Instructor Tektronix fﬁj 7@

Enter administrator password

i wrial
ourse Scope tutorial
Password:

Default password is "admin”

Exercise  Rise and fall time meas ~

Configure
OK Cancel Instrument

Total Instruments
Normal
Error

Disconnected Test Report

Figure 67: Change password
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Input the old password, the following dialog box is displayed. The default
password is “admin”.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

- _—~
# Instructor Tektronix v ;)l//‘ N e

Change Password

Course Scope tutorial

Old Password

Exercise  Rise and fall time me: Configure

Instrument

Cancel

Total Instruments
Normal
Ermor

Disconnected Test Report

Figure 68: Input new password
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. NOTE. In July 2017, the license policy and nomenclature was changed for
License Management TekSmartLab™ software.

The legacy system, with TSL3000B, will continue to be supported in the software,
S0 you can use your current activation code when upgrading to the latest version
software.

The new application license, with TSL3000B-FL, offer floating licenses (FL) that
can be checked in and out of the Tektronix Asset Management System on the
Tektronix.com Web site.

How to purchase. Contact your local Tektronix Account Manager to purchase
TSL3000B-FL. After purchasing, you will receive an email listing the options
purchased with the URL to the Tektronix Asset Management system that will
enable you to manage your licenses.

You can manage your licenses using the Tektronix Asset Management System
found athttp://www.tek.com/products/product-license.

The Tektronix Asset Management system provides an inventory of the license(s)
in your account. It enables you Check-out or Check-in a license and view the
history of licenses.

How to install. Click About -> License Management on the menu bar and the
following figure is displayed.

Tektronix Teksmartiab™ Home Setting Administrator About

< TekSmartLab

HITTMDTK

Figure 69: Install license
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Click the Install License button and browse to the location where the license file
is located. Select the license file and click Open. After the successful installation
is finished, the software is listed in the table.

Tektronix TekSmartlab™ Home Setting Administrator Abeut

< TekSmartLab

License M

+ Instruct

Course

Exercis

NATTMDTE

Figure 70: License install finished

How to move the license to a different host. You can return the license purchased
and assign it to a different host on the other computer. TSL3000B-FL is a
floating license, and it can be returned unlimited number of times and assigned
to a different host.

In order to move the license to a different host, follow these steps:

ClickAbout > License Management and select the license to return and click
Remove.

Tektonix Teksmario® ~— Home Setfing  Administrator  About

< TekSmartLab

+ Instruct

Figure 71: Select a license to remove

54 TekSmartLab User Manual



TSL3000B

TekSmartLab User Manual

Browse to the location where you would like to place the exit file (for example, a
network drive or a USB memory stick), and click Save to generate the exit file.

Telitronix TekSmarilab’ Heme Setting Administrator  About

TekSmartLab

HostID:

4+ Instruct  j5crack

ENGINEERING LIC

(®

Jourse

Exercig

NITTMDTK

= e belders

Figure 72: Export the license file

Login to your account on TekAMS (Tektronix Asset Management system) and
upload the exit file. Once the license is returned successfully, it can be re-assigned
to a computer with different host.

About. Click About -> About on the menu bar to display the software
information, as shown in the following figure.

Telitronix TekSmartlab” Home Setting Administrator About

TekSmartLab

#+ Instructor

About

Course
TekSmartLab(TM)
Version 300

Exercise
Configure
For more information, please visit the website <

Instrument
vwwtek com/teksmartiab

Total Instruments
Normal

Error

Disconnected Test Report

Figure 73: Software information
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Lab instrument management

This part describes how to manage the instruments in the lab more effectively
with TekSmartLab.

Configure bench and lab ~ You can click Setting > Bench/Lab Layout Config to set the lab layout as well as
layout  the bench layout.

Tekitronix TekSmarilab” Home Setting Administrator About
Language
Bench/Lab Layout Config
General Information rtLab
Firmware/Courseware Update

= Instructor Tektronix

Saved Confi: Exercise Material
Course  scope tutorial g

Exercise  Rise and fall time meas - Configure

Instrument
Report Template

Total Instruments
Normal
Error

Disconnected Test Report

Figure 74: Bench/Lab layout configuration
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The following figure is displayed when you click Bench/Lab Layout Config.
The Bench Layout Configuration tab is chosen.

Tektronix TekSmartlab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration
Bench Layout =
1 Oscilloscope ¥ 2 Arbitrary Function Generator
- CH 1 Output [ON

‘ Exémplé - Example

3 Digital Muttimeter v 4 Power Supply v

Default Setup Default Setup

-123.125 mV o o
Example Example

M ent  DCV

1000 V

Figure 75: Bench layout configuration tab

You can choose the bench layout templates in the Bench Layout Configuration
tab. The Four-instrument layout template is chosen by default, as shown above.

You can click the arrow in the upper right corner of the square representing each
instrument to choose the type of the instrument, as shown in the following figure.
Scope represents oscilloscope, AFG represents Arbitrary Function generator,
DMM represents digital multimeter, and PWS represents power supply.

Tektronix TekSmarilab™ Home Setting Administrator About
Bench Layout Configuration Lab Layout Configuration
Bench Layout
Scope
AFG

DMM
PWS

Example Example

Example Example

Figure 76: Choose the instrument type
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The following figure shows the bench when four instruments are chosen.

Tektronix' TekSmartLab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration
Bench Layout

1 Oscilloscope ¥ 2 Abitrary Function Generator

CH 1 Output JON

~ Example

Example

3

3 Digital Multimeter v 4 Power Supply v

Default Setup Default Setup

-123.125 mV
E

xample

Measurement  DC V

Range

Figure 77: Instrument chosen

You can click Apply in the upper right corner of the page to apply the settings to
all the other benches in the lab.

A dialog box for you to confirm is displayed. Click Yes, the bench settings are
applied to all the benches in the lab.

If you try to apply the settings without choosing the instruments, a warning
pops up.

Select the Lab Layout Configuration tab, as shown in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

Bench Layout Configuration
Row 5 4 Column 8 ¢ Total 40

Lab Layout Configuration
Number |8y Row

1 2 3 B 5 6 7

Scope | AFG | DMM  Scope | AFG | DMM -~ Scope | AFG | DMM  Scope | AFG ’DMM Scope | AFG Scope | AFG | DMM - Scope | AFG Scope | AFG ‘DMM

PWS ‘ ‘ PWS. PWS PWS PWS PWS. PWS

9 10 1" 12 3 15 16

Scope | AFG ‘DMM Scope | AFG | DMM  Scope | AFG | DMM  Scope | AFG ‘DMM Scope Scope [ AFG | DMM  Scope | AFG Scope | AFG ‘DMM

PWS ‘ ‘ PWS PWS PWS PWS PWS PWS,

17 18 9 20 21 22 23 24

Scope | AFG | DMM  Scope | AFG ‘DMM Scope Scope | AFG ’DMM Scope | AFG Scope | AFG | DMM  Scope | AFG Scope | AFG ‘DMM

PWS ‘ ‘ PWS. PWS PWS PWS. PWS ‘ PWS. PWS

25 26 28 29 30 31 32

Scope | AFG ‘DMM Scope | AFG ‘DMM Scope Scope | AFG ‘DMM Scope | AFG Scope [ AFG | DMM  Scope | AFG Scope | AFG | DMM

PWS ‘ ‘ PWS. PWS PWS. PWS PWS.

33 34 6 37 38 39

Scope | AFG | DMM ~ Scope | AFG ’DMM Scope | AFG

Scope | AFG ‘DMM Scope | AFG Scope | AFG | DMM  Scope | AFG Scope | AFG ‘DMM

PWS. PWS. S PWS. PWS PWS. PWS

Figure 78: Lab layout configuration tab
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You can arrange the layout by input the number of rows and columns in the Lab
Layout Configuration tab.

You can number the benches by rows or columns. The benches are numbered
by rows in the figure below.

You can double-click a bench to delete it, as shown in the following figure. You
can also double-click the blank to add the bench back.

Tektronix' TekSmartlab™ Home Setting Administrator About
Bench Layout Configuration Lab Layout Configuration
Number |8y Row Row | 5 4 Column 8 + Total 34
1 3

Scope | AFG | DMM F DMM | {Scope | AFG | DMM Scope | AFG

PWS PWS

7 8 9 i : 1

Scope | AFG | DMM DMM DMM G Scope | AFG | DMM
PWS
17
G | DMm G | DMM DMM Sccpe‘AFG DMM | {Scope
|

22 23

G | DMM | {Scope | AFG | DMM | {Scope | AFG | DMM | Sc G | DMM

PWS PWS

G | DMM | {Scope | AFG | DMM | {Scope | AFG | DMM | iScope Scope | AFG | DMM | |Sct

PWS PWS PWS PWS

Figure 79: Arranging benches

NOTE. If you switch between numbering the benches by row and by column, the
adding and deleting done previously will be canceled.
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You can also select Manual to number the benches manually, as shown in the

following figure.

Tektronix' TekSmartLab™

Number | Manual Row 5

‘m

{Scope | AFG | DMM | |

5 | DMM |

Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration

+ Column 8 + Total 34

DMM | |

G | DMM ||

Figure 80: Number the benches manually

G |DMM | ! G | DMM |

G | DMM | G |DMM |

G | DMM |

Make sure you don’t number two benches with the same digit, or the following

warning pops up.

Tektronix TekSmarilab®

Number | anua

Home

or About

Lab Layout Configuration

Figure 81: Two benches numbered the same

You can click Apply in the upper right corner of the page to apply the settings.

A dialog box for you to confirm the setting is popped up. Click Yes to complete
the lab configuration.
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Centralized instrument  You can configure the instruments and then distribute the settings to up to 100
configuration ~ benches.

Configuring instruments. Take the following steps to configure the instruments:

1. Click Configure Instrument pane on the home page. The following figure

is displayed.

< Back Status Unselected [T ] Selected Configure succeed Configure fail Unselectable
Bench Selection |1 2 3 4 5 6 7 9 10 1" 12

(:\J Capture

Figure 82: Configure instruments

2. Click the icon of an instrument to select it, and the following figure is
displayed.

< Back  Status

Unselected [ | Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 7 3 4 5 6 7 8

Logic Analyzer

Help Everywhere

Trigger

Source

Slope

Horizontal
V-Scale Al V-Scale H-Scale
V-Position G \LPosition V.Position H-Position

Figure 83: Instrument selected
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3. Set the parameters of the instrument selected.

NOTE. If you tick Default Setup, the instrument will be reset. Make sure you
leave all the parameters unconfigured.

If you tick Default Setup and configure some parameters, the instrument will be
reset and then the parameters will be configured.

NOTE. The parameters that can be set are based on the first such instrument
connected to the software. For example, if the first oscilloscope detected by the
system is two-channeled, the parameters for CH3 and CH4 cannot be configured.

4. Click the white arrow on the right side of the Bench Selection bar to collapse
it, and the following figure is displayed. The numbered bench icons in blue
is selectable.

< Back Status Unselected [T ] Selected Configure succeed Configure fail Unselectable

Bench Selection \f'.:\l',\ Capture

All

L]
o Inverse

¥ Logic Analyzer
Help Everywhere

Trigger

Source ~ Type

Slope v Level

Vertical & Horizontal

b H2 Horizontal

V-Scale V-Scale V-Scale &5 V-Scale H-Scale
V-Position - V-Position £ V-Position V-Position H-Position

Figure 84: Select bench
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5. Select the bench icon and click Apply on the upper right corner of the page,
and the following figure is displayed. The numbered bench icon displayed in
green means the bench is successfully configured. If the icon turns red, select
the bench and repeat the configuration. If the icon stays red, please check the
cable connection, and then restart the instruments and TBX3000A. If the fault
is still not cleared, please perform a self-check of the instrument by referring
to the instrument user manual.

< Back  Status Unselected [T ] Selected Cenfigure succeed Configure fail Unselectable

Bench Selection {':\j Capture Agply

All

o
=1, Inverse

Logic Analyzer

Help Everywhere

Trigger

Source

Slope

1
i
[
|
[
i
[
Ol
[
[
i
[
[
[
f
[
f

Vertical & Horizontal

s Horizontal
V-Scale V-Scale o V-Scale il V-Scale H-Scale
V-Position ¥l V-Position 2o V-Position V-Position H-Position

Figure 85: Bench configured

6. You can also click Capture to get the configurations from a configured bench
to distribute to other benches.

NOTE. If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other.

1t is recommended that the same instrument types that are connected to the system
are of the same series, or even the same model. For example, if the system already
has configurations for CH3 and CH4 for oscilloscope, the configuration won t
succeed if one of the oscilloscope that is connected to the system is a two-channel
oscilloscope.
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Firmware upgrade. Take the following steps to upgrade the firmware:

1.

Select Setting -> Firmware/Courseware Update on the menu bar. The

following figure is displayed.

Tektronix TekSmartlab™ Home Setting Administrator About

Status Unselected Selected Configure succeed

Bench Selection 1 2 3 4 5 [ . 8 9 10

Firmware / Courseware Upgrade

Instrument Mode!

Upgrade Type

File

Figure 86: Firmware upgrade

2.

3
4.
5

Choose the instrument type.
Choose Firmware.

Choose the upgrade file.
Click Apply.

|

Configure fail Unseleciable

12
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Centralized instrument monitoring. Click the lab information area on the main
(Home) page. The following figure is displayed.

Lab Overview
Bench Status Online Offline Instrument Status Working Error Offline

1 6

]
2 i 4 5 7 8
SCOPE AFG | DMM (S »= oMM o-: DMM .-= DMM  SCO DMM ..-; DMM .-: DMM  SCO . DMM
PWS PWS PWS PWS PWS PWS PWS PWS

10 1 14 15 16

9 12 13
u: DMM‘ s DMM 4 AFG | DMM  sCO nm w: DMM  SCOP mm tv= DM

19 20 21 22

17 18 23 24
o ﬂ o o E owm oM s ﬂ o ﬂ oM ﬁ oW
PWS. PWS. PWS PWS PWS PWS PWS PWS.

30

25 26 27 28 29 31 32
5 o oum scom mm . ﬁ o o H
33 34 35 37

36 40

39
: mm ..= -= corel 476 | 0 pe ..-:
&

Figure 87: Lab overview

The status of the bench and instruments are represented by different colors, as
explained in the status bar in the upper part of the page. For example, in the above
figure, bench 1 is online, and the four instruments of bench 1 are working.

You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

Default Setup
Output

-58.862uVDC o

Output

C Set
Measurement  DCv

Output

Range Auto

Set

Figure 88: Bench page

For the MDO3000 oscilloscope, you can switch between two modes: Scope
(oscilloscope) and SA (spectrum analyzer), as highlighted in the above figure.
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You can monitor and control an instrument in detail by clicking the expanding
icon (highlighted in yellow box) in the upper right corner on the instrument pane.

Using an oscilloscope as an example, the following page is displayed after you

click the expanding icon. If you want to go back, click restore icon in the upper
right corner.

Bench1

Default Sefup  AutoSet ¥ Sigle Run /

Cursor Enable
Disable
- o

Source CHi 2 Off

Measurement

CH1 ¥ Frequency

CH2 ~ Period

Trigger

Source  CH1 ~ Type Edge ~ i

HiSEEEE

v Level 0V

Vertical & Horizontal

o v|1x
V-Sca 500 mvV.
V-Position 1V

Horizontal
V-Scale H-Scale 400ns il

V-Position H-Position 0 s

Figure 89: Oscilloscope page

If you select Waveform, the waveform is displayed in real-time on this page.
If you select Screen, a snapshot of the waveform on the actual instrument is

displayed here. You can right-click on the waveform to save it. You can click
Screen again to take another snapshot.

You can disable Autoset on the upper right side of the page to have the students
practice setting parameters manually for the experiment. The Autoset button
is displayed in gray if you disable the function. If you enable the function, the

Autoset button is displayed in blue. You can click the button to execute the
auto setting.
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As shown in the following figure, you can set the parameters for the waveforms in
the Vertical & Horizontal part of the page.

< Back

1 Scope:MDO3102,No_Serial

Waveform Screen

Help Everywhere

Vertical & Horizontal

oc vi1x
V-Scale 500 mV/
V-Position 1V

V-Scale 500 mV
V-Position -1.05 V

Figure 90: Vertical and horizontal settings

Bench1

V-Scale
V-Position

Logic Analyzer

V-Scale
V-Position

Default Setup  AutoSet ¥  Single Run /
Cursor

Source CH1 v Mode [ime

Measurement
CH1 ~ Frequency v 999.933 kH:
CH2 ~ Period v 1us

Trigger

Source  CH1 v Type Edge

Slope  Rise v Level 0V

Horizontal
H-Scale 400 ns

H-Position 0's

You can either input values into the boxes or click arrows or plus and minus
symbols to set the parameters. In addition, the highlighted number 1 in yellow,
number 2 in blue represents the V-position of the two channels; the highlighted
yellow arrow represents trigger level. You can drag these symbols to change

the values directly.

For the channels, DC is the mode of coupling, and 1X is the value for attenuation.
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As shown in the following figure, you can also use cursors for measurements
on this page.

< Back

Bench1

1 Scope:MDO3102,No_Serial

Waveform Screen Help Everywhere Logic Analyzer Default Setup ~ AutoSet ¥  Single Run /
Cursor

Source CH1 v Mode Fime

Measurement

CH1 ~  Frequency v 999.933 kH:
CH2 ~ Period vi1us

Trigger
Source  CH1 v Type Edge
Slope Rise v level 0V
Vertical & Horizontal

CH1 DC C X Horizontal
V-Scale 500 mV V-Scale 500 mV V-Scale V-Scale H-Scale 400 ns
V-Position 1V - V-Position -1.05V - V-Position V-Position H-Position 0s

Figure 91: Cursors
Use these steps:
1. Select the Source and Mode in the Cursor area.

2. If you select Time for the mode, cursors “a” and “b” are displayed on
the waveform. Move the cursors and the measurement result is displayed
automatically in the box at the upper right corner of the waveform display.
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Asset management. You can select Administrator -> Asset Management on the
menu bar to manage the instruments. The following figure is displayed.

Tektronix' TekSmartLab™ Home Setting Administrator About

Asset Management

S 2016-04-11 =] Stop 2016-04-21 =]

Bench No. Model Number Query

Modeitumer el unber bty et~
1 1 3

2016-04-20 09:56:48 TBS 12028
4 c C018469

104
C040464
C018001
C046804
C080001
C048084

e
€080014
| cotas01
€046014
€020014

Figure 92: Asset management

You can set the parameters and then click Query to acquire the information
about the instruments. Then you can click Export to export the result as an
Excel document.
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Lab teaching flow management
This section describes how the TekSmartLab helps optimize lab teaching flow.

Create and select an  As shown in the following figure, you can click the plus symbol in the course
exercise  information area to create a new course. The dialog box pops up for you to input

the information.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

Create a new exercise

= Instructor Tektronix

Course Scope tutorial Instructor Tekironix

Course Scoj
Exercise  Rise and fall time Configure
Exeraise Instrument

Normal
Error

Disconnected Test Report

Figure 93: Create a new course

You can input the name of the instructor, the name of the course, and the name of
the exercise, and then click Ok to save the exercise, as shown in the following

figure.

Tektronix TekSmartlab™ Home Setting Administrator About

TekSmartLab

Create a new exercise

#+ Instructor Tektronix

Course Scope tutorial Instructor Tektronix

Course

Exercise  Rise and fall time rr Configure

Exercise Demo Instrument

Normal
Error

Disconnected Test Report

Figure 94: Create new exercise
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You can select an existing exercise, as shown in the following figure.
Telitronix' TekSmarilab™ Home Setting Administrator About

TekSmartLab

4+ Instructor Tektronix

Saved Config

Course Scope tutorial

Exercise  Rise and fall time meas - o Configure
|Rise and fall time measur
Peak to peak measureme Report Template
Demo

Instrument

Total Instruments
Normal
Error

Disconnected Test Report

Figure 95: Select an existing exercise

NOTE. You can delete an exercise by clicking Administrator > Exercise
Management. Only the administrator has the access for deleting exercises.

Savelrecall instrument  This function allows you to save instrument configurations, or to recall instrument
configuration configurations.

You can click the Saved Config area on the home page to configure the
instruments and then save the settings. The following figure is displayed.

< Back  status Unselected [ | Selected Configure succeed Configure fail Unselectable
Bench Selection 1 2 3 4 5 6 i 8 9

AFG O DMM

CH1 Output 2 Output
! : Defaut Setup

Measurement

Waveform Mode Range

Frequency Ampitude

Scope

Defaut Seiup

Output
Set Vottage
Set Current

Output

Set Voltage
Set Current

Output
Set Voltage
Set Current

H-Scale

Figure 96: Configure the instruments
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As shown in the previous figure, all the instrument types that are supported by the
software are displayed here. You can configure all the instrument types here as
long as you tick the box in the left upper corner of each instrument type.

NOTE. The differences between configuring instruments on the home page and
here are that:

* The configuration can be done to four instrument types at the same time in
this page.

* The configuration can be saved here and recalled for later use.

NOTE. If two of the same instrument types are placed in the same bench, the
configuration of one instrument will be applied to the other:

You can set the parameters for the instruments as shown in the following figure.

< Back  status Unselected [ ] Selected Configure succeed Configure fail Unselectable

Bench Selection = 1 2 3 4 5 6 7 8 9

AFG [} DMM

CH1 Output [oN v CH2 Output [GFERIN ~
4 s Default Setup

w
Measurement

Waveform

Sine
Frequency
1 kHz

Scope
Default Setup
Output
Set Voltage
Set Current
Output
Set Voltage
Set Current
Output
Set Voltage
Set Current

H-Scale

200 mV 400 us

Figure 97: Configure the instruments

NOTE. The parameters that can be configured are based on the first instrument of
the type that is detected by the system.

You can also select a preconfigured instrument in another bench and click
Capture to acquire its configurations to apply to the instrument you want to
configure. The waveform of the oscilloscope and arbitrary function generator will
only be displayed when you click Capture.

You can click Save to save the configuration for future use. You can also select
other benches to apply the configurations.
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Student access  This chapter introduces features that this software provides for students to access
the experiments on a webpage.

Generate QR codes for benches. The server generates a webpage for each bench
for students to access the exercise. The students can log in the webpage by
scanning the QR code generated for the webpage or the IP address.

Take the following steps to generate QR codes for the benches:

1. Seclect Setting -> General Information on the menu bar to generate QR
codes for the benches, as shown in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information

Lab Information

Lab Name

QR Code Print Preview

Bench1
Server IP WiEi

Single Bench NO.
Batch

Width(Unitmm) 240

Comments

hitp//192.168.1.66/login.aspx?deskid=1

Print

Figure 98: Generating QR code

2. Set the server IP in the TekSmartLab network. You can choose WiFi, LAN, or
input the IP manually.

NOTE. The server should be set with static IP so that the address for each
webpage won 't change.

NOTE. If computers for students installed on the benches and TekSmartLab server
belong to the same campus network, then set the server IP as the IP address in
the campus network. Thus, the computers on the benches are able to access the
benchspecific IP address distributed by the server.
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3. Input the bench number. If you want to generate the QR codes in batch for
benches, tick Batch, and then input the bench numbers.

4. Input comments if necessary.
5. Click Print under the QR code preview to generate the codes.

You can paste the printed QR codes on their correspondent benches in the lab.

Accessing the webpage. Students can take the following steps to access the
bench webpage:

1. Connect your smart phone or computer to the TekSmartLab network. If you
are using the computer on the bench, and the bench and server are connected
to the campus network, then you are not required to be connected to the
TekSmartLab network.

2. Taking bench 1 as an example, scan the QR code, or input the address to log
onto the bench webpage. The following figure is displayed.

= UL LA
Lab Name: TekSmartLab
Bench: 1
Course Name: Scope tutorial
Exersise: Rise and fall time
measurement
Student Name:

Student ID:

[)Remember me
Scope Snapshot

Figure 99: Log in to the bench webpage

3. Input your name and ID to log in the webpage.

NOTE. Your Student ID should be unique, whereas Student Name does not need
to be unique.

You can also take a snapshot of the oscilloscope screen by clicking Scope
Snapshot on this page.
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Exercise material sharing  In the course information area, you can click the Exercise Material area on the
main (Home) page to share the exercise material with students. The following
figure is displayed.

Exercise Material

Introduction:
TekSmartLab server can work as an FTP server,you can add the material here so that the students are able to download it from the web page of their devices.
The material can be in the format of ppt, word, video etc.

oae |Twe sa  |mass |

TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf 812712014 11:20:44 .. | pdf 777537 Bytes

Figure 100: Edit exercise material

On this page, you can add or delete exercise material on the server.

Exercise Material

Introduction:
TekSmartLab server can work as an FTP server,you can add the material here so that the students are able to download it from the web page of their devices.
The material can be in the format of ppt, word, video efc.

iane e e e R,
ST_AFG_Cursor_Rise-Fall-Time_Measurement. pdf 4/20/2016 11:28:40 pdf 76414 Bytes
TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf 8/27/2014 11:29:44 pdf 777537 Bytes

Delete

Figure 101: Add or delete exercise material
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On a student’s smart device, as shown below, students can download the exercise
material to their devices.

ESIEEGEE &5 Material
=7

I ST_AFG_Cursor_Rise-Fall-Time_Measurement.p

I TBS1000B-EDU-Oscilloscope-DataSheet-1_0.pdf

Figure 102: Download exercise material

Test report editing  In the course information area, you can click Report Template button to import a
test report template to the server. You can create a test report template by using
Microsoft word (only .docx format is supported) and then import the .docx file to
the server, as shown in the following figure.

Test Report Template

Introduction:

Report template can only be in the format of .docx created by Microsoft Word. If will be transformed to HTML when it is loaded in the web page on students' devices.
When the template in word is transformed to HTML, only the texts and images are kept. You can click Preview to see the uploaded template in HTML or refer to the
example shown below.

Test Report Template C: g ek >\labs\Rise and fall time

() Preview

Example
Report template in *. docx format Report template in HTML format

nnot be saved

o Text and image can be saved. e Text and image can be saved

)
4 a Tolaronix
REVOLUTIONERmG. 3 a Toumontc REVOLUTIONERING ;ﬁ

@ Header and footer cannot be saved. ® Header and footer cannot be saved

® Inserted equation, as below, cannot be

® Inserted equation, as below, cannot be. T vt
o saved unless it is changed to be an image

saved unless it is changed to be an image-

T

k=0

Figure 103: Importing test report template

The template is transformed into an HTML file once it’s imported to the server.
You can click Preview to see how it is displayed in HTML format.
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On a student’s smart device, as shown in the following figure, students can create
a new test report by clicking New Report.

est Report

New Report

Y& Material

Figure 104: Create a new test report

When you create a new test report on your device, the defined template is
automatically loaded, as shown in the following figure.

i=|TestReport  j& Material

BN E Scope Image

40 ¥ e EEIE

A ~ [Al - FontFamiy~ FontSizes~
B 7 - -

Text and image can be saved
8

EroumotERNG. ; [y
Header and footer cannot be saved
Inserted equation, as below, cannot be
saved unless it is changed to be an image

Figure 105: Create a new test report
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You can edit the report and insert the test result. For example, click Scope Image
to insert the oscilloscope snapshot into the test report, as shown in the following
figure.

[(=|TestReport  j&5 Material

[l Scope Image

o Text and image can be saved

s B
CERING. g
Header and footer cannot be saved
Inserted equation, as below, cannot be
saved unless it is changed to be an image

Figure 106: Scope snapshot inserted
After you are finished editing the test report, you can click Submit to submit it.

You can also download the test report locally to edit it in a Word file.
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You can click Test Report on lower right side of the home page to check a
student’s test reports. The following figure is displayed.

Test Report

St siop
Instructor Course
Bench NO.
Student ID Query

Thursday, April 21, 2016

Exercise
Student Name

2016-04-21 10:31:08

| Instructor
Tektr

[ Tektr

Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix

| Course Name
Scope tutorial
Scope tutorial

Scope tutorial
Scope tutorial
Scope tutorial
Scope tutorial
Scope tutorial

Scope tutorial
Scope tutorial
Scope tutorial

pe tutorial
Scope tutorial
Scope tutorial

Figure 107: Query test report

| Exercise
Rise and fall time measurem

Rise and fall time measurem... |2

Rise and fall time measurem
Rise and fall time measurem

Bench No.

Rise and fall time measurem... |5

Rise and fall time measurem

Rise and fall time measurem..

Rise and fall time measurem.

Rise and fall time measurem.

Rise and fall time measurem.

Rise and fall time measurem

Rise and fall time measurem

Rise and fall time measurem

Rise and falltime m

|Rise and failtime m

| d fall time measurem
d fall time measurem

Detail Export Report List

Student Name | Student ID
Tom
Jacky

Jerry

Je: Chang
Mike Edwald
Wang Tian
Tina Tang
Gary Wee
Chelsa Tang
Marry Ying
Patrick Ma
BrycelLi
Richeal CHEN
Jacky Wang
Tony Wu
Harry Ji

Export Report Files

You can input the time next to Start and Stop and click Query to get the students’

report.

You can double-click a report to check it, or choose a report and click Detail to

check it.

You can click Export Report List to export the query result in an Excel document.

You can click Export Report Files to export all the text reports.

You can click Delete to delete the selected report.
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Case Study

Set up a TekSmartLab network system

80

Introduction

In order to ensure the stability and security of running the TekSmartLab solution,
we should set up an independent network other than taking advantage of the
existing network, for example, the campus network. If the lab server is connected
to the campus network, we should add a network card or a USB WIFI dongle
for TekSmartLab network. Thus the server is working simultaneously with the
TekSmartLab network and the campus network.

The following figure illustrates that the server is connected to the TekSmartLab
network through Wi-Fi, and also connected to the campus network through LAN.

Bench 4

Bench 3
Bench 2 )
=
Lab Server

TSL3000B

TekSmartLab
Network

Figure 108: TekSmartLab

You can set up the TekSmartLab network wireless, through cables, or a mix of
both according to the actual lab requirements.

NOTE. Make sure that TBX3000As on each bench are in the same network with
the server at all times, which means that you can ping the IP address of the
TBX3000As on the server successfully.
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Configure the network

TekSmartLab User Manual

To set up a wireless network:

Configure the wireless network using these settings:

Wireless network mode: 2.4GHz, 802.11n

Set the number of the Max. Associated clients larger than the number of
devices that are connected to the network. For example, if the network is
connected to 1 lab server, 20 benches through TBX3000A, and 20 smart
phones from students, set the number of Max. Associated clients larger
than 41.

WIFI signal level: >= -50dBm (recommended)

WIFI signal to noise ratio: >=35dB (recommended)

For the wireless equipment:

If the number of benches is larger than 15, it is recommended to use corporate
grade router (such as TP-LINK TL-R600VPN) plus Access Point devices
(such as TP-Link EAP120) to form a network. 1 AP for every 15 benches

is recommended.

If the number of benches is equal to or smaller than 15, a corporate grade
router (such as TP-LINK TL-ER604W) is enough for the network.

NOTE. The WIFI coverage will vary by cases. Please consult with your IT
department or the router manufacturer for more information.

If you are going to set up a wired network, make sure that every bench has an IP
address. TBX3000A supports both dynamic IP and static IP.
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Install TekSmartLab on the lab server

Refer to Installing TSL3000B, (See page 8, Installing TSL3000B.) to install
TSL3000B properly on the lab server.

Note that the lab server should be set with a static IP address, and the software
should be started only after the lab server is connected to the TekSmartLab
network.

Configure the TBX3000A
Connect the TBX3000A 1. Install the USB-WIFI dongle on each TBX3000A.

2. Connect the instruments on each bench to the TBX3000A using USB cables,
and then power the instruments on, as shown in the following figure. The
figure is an example of only two instruments connected to the TBX3000A
on the bench.

bl USB cables to connect
Flinstruments to TEX3000A

Figure 109: Connecting TBX3000A
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Log onto the TBX3000A  There are two ways to log onto the TBX3000A configuration page on a computer:
configuration page

B Connecting the TBX3000A directly to a computer.
B Connecting the TBX3000A to a router

Connect the TBX3000A directly to a computer. Connect the TBX3000A to a
computer as shown in the following figure:

Figure 110: Connect the TBX3000A directly to a computer

Set the LAN connection parameters of the computer (with path Control Panel >
Network and Internet > Network and Sharing Center for Win7 operation system)
according to the figure in the below:

() (8 o CommmiPosst 3 ik anliasnd 5 st and Thaies) Costen 2
| Cawetrcd Faverl bicome @
Wew your basic nebwork information and set up connections
ol - ¥ @
: e iy Theay Commgediar Wt gl sty It
] Wi o Botien mamanrky srt o dacnenart
Po et 4 Sk ke
i Wi s -
| _ 1. Local Area Connection
I ‘!. w.-:-;-« ;-@;-;nmvrw--—mmn 1 Foo et
e i i e i
i o ————— I o oo P
(e " Sormr ittt | o — 3. Internet Protocol 7 v st o 1o e
STt ol CormecSuty: dor et appragrate P peitegs.
sm Version 4 (TCP/IPv4) o s st
Do @ Ut P Sl O mlidwms.
Ipoed - P e - e
| Cotta Proper‘tles [Ar—— 755 058 .28, 0
-~ — Cafa st atreay LS
H - D: -v-m:mb-m-nhwwth- -I-J.nh'!'v-r‘l."ﬂ.r.-vll#lﬂ;w-n
2. Properties | =— WlarS-jpliessesemenne .
e o 4. Select “Use the
e e e Bt : o
E . following IP address” and
L Dowe ||| .
- ——— input the parameters

Figure 111: LAN configuration
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The LAN parameters are set as follows:
IP address : 192.168.1.66

Subnet mask: 255.255.255.0

Default gateway: 192.168.1.1

Enter the IP address 192.168.1.101 in your browser, and then configure the
TBX3000A.

Connect the TBX3000A to a router. Connect TBX3000A to a router as shown

in the following figure:
. LAN cable

Router WIFI or LAN cable

Figure 112: Connect TBX3000A to a router

Make sure the computer is connected to the ‘school lab 1’ network. If the
computer is successfully connected via WIFI, you will see the network as shown
in the following figure.

Wireless Mztwork Connection ~

school_lab_1 Connected 1._“!
; o

AuthorizedGuest N

TekSmartLab-Demo 1.\_1“_

Open Metwork and Sharing Center

Figure 113: Computer connected to ‘school_lab_1’ network

NOTE. The ‘school lab 1’ network is generated by the router.

TekSmartLab User Manual



Case Study

Configure the TBX3000A
for the wireless network
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Enter the IP address 192.168.1.101 into your browser, and the welcome page is
displayed as shown in the following figure. Then configure the TBX3000A.

L= ]

W=

[ welome
Q94 % D192.168.1.101

Welcome Page

LAN € Instrument Model: TBX3000A
Firmware Revision: 01.01.06_20150303
'WIFI C
Serial Number: C000001
Set Password
LAN Connection Status: Connected
'WIFI Connection Status: Disconnected
Host Name (FQDN): | Benchl local

Figure 114: TBX3000A welcome page

1. On the welcome page of TBX3000A, Select LAN Configuration on the left
side to enter into LAN configuration page.

LAN Configuration
Welcome Page ;
== =
| TCPIP Configuration Mods: heanual
IR Commemnon. 1P Address: 162 1651101
Set Paszword | Subnet Mask: 5 2% 2950
| Detautt Gateway: 182 468.1.1
| Connact Stas: Cannested
| Speed: 100hbs

Figure 115: LAN configuration

2. Click Modify to enter into Modify LAN Configuration page. Input “admin” if
password is required.

Medify LAN Configuration
Welcome Page
LAN Configuration = v
. (. Autormatic
— TCPIE Coniguistion Moda: ® :
sote q | IP Address: 152 A8 1,901
| | Subeet Maskc 755,355 255.0
Defiault Gateway: 182.168.1.1
Hast Name: [Bonemt |

Figure 116: Modify LAN configuration
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3. Change the host name into BenchX, in which X represents the number of the
bench on which the TBX3000A is placed. The above figure uses Benchl
as an example. Click Submit to finish. Note that the TCP/IP configuration
Mode and other settings should not be changed.

4. Click WIFI Configuration on the left side to enter into WIFI configuration
page.

Oy P = © || & WFl Configuration =

WIFI Configuration

Hostnarme: Benchil
- | TCPAP Configuration Mode: Manual

WIFI Configuration P Address

Set Password Subinet Mask:

Defaull Gateway:

S5ID;

Connect Status: Disconnacied

(Lot ] [ scmar )

Figure 117: WIFI configuration
5. Click Scan AP to search for the WIFI network, as shown in the following

figure.
—_ . [
[ httn://192.168.1. 101/ =
< Q90w 01921681101 T —
WIFI AP List
Page
SSID BSSID Strength Security
LAN Configuration
©  TekSmartLab-Demo 14:75:90:29:20:52 all WPAPSKITKIP
WIFI Configuration
SetP, " DanaherTM 68:8D:AB:D2:T5:A0 al WPA2-802. TWAES
@ AuthorisedGuest 68:BD:AB:D2:T5.A4 al None =
@ AuthorizedGuest 688D AB.D275.A2 al None.
66:8D:AB:D2.75:A1 al WPA2-802 TWAES
® C0:61:18:804C:06 i WPAPSKIWPA2-PSKIAES
I @®  school_lab_1 50:BD:5F:37:58:86 all WPA-PSKJWPAZ-PSWAE4 m
©  school_lab 2 50-BD-5F-37:68:10 al WPAPSKWPA2-PSKIAES
©  teksmartlablbj C0:61:18:80:53:00 al None.
©  richeal-smartlab 52'BD5F-53.B3 50 a None.
DanaherTM BAAEI1E4ABO K WPA2-802 TWAES
Tektronix:
152.168. 1. 101 fegi-bin/ScanAP. el 7

Figure 118: Scan AP
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6. Choose school_lab_1, and then click Apply.

7. [Ifthe ‘school lab 1’ network can only be accessed by a password, a prompt
pops up as shown in the figure below. Enter the password and click Connect.
Once connected, the WIFI indicator on TBX3000A will blink twice a time.

[ http:4y192.168. 1101/ x W ) 5 ' L o]
< QDG Y [0192.168.1.101 o - =
Wifi - config
Welcome Page
—_ SSID schoal_lab_1
WIFI Configuration Security Type WPAPSK ~
Sat Password Encryption Type AES ~
PSK Key teksmartlab
[ Comeat | [ Back |

Figure 119: Input password

8. Check the Host Name, SSID and Connect Status, and TCP/IP configuration
Mode is Auto as default.

TekSmartLab User Manual

WIFI Configuration

‘Welcome Page

Tan 1 | Hostmame: Bencht
TCRIIF Genfiguration ode Aty

Tozond IF Addinss: 1921851150

Set Pasaward Subinet Mask 2557552550
Do Gabeway: 10218811
S5I0; sehaol_lab_1
Connect S2abss: Connected
Signal Intensity: Excellert

Figure 120: WIFI configuration

) (=
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9. Ifyou need to set the static IP address, click Modify. Enter “admin” if
password is required. Select TCP/IP Configuration Mode to be Manual, and
set the IP address, Subnet mask and Default gateway manually. Click Submit
to finish. Note host name should not be changed.

LI i L]

Modify WIFI Configuration

Welcome Page

LAN C

Automatic
WIFI Configuration TCP/IP Configuration Mode: ® Manual

Set Password IP Address: 192.168.1.111

Subnet Mask: 255.255.255.0

Default Gateway: 192.168.1.1

Host Name: Bench1

Figure 121: Modify WIFI configuration

10. Click Welcome Page, and the configuration is done as shown in the figure

below.
[ [ i} I .

Welcome Page

‘Weloome Page .
Insfrument Madel TEX0004

LAM Configuration |
Fimnarne Revdson 200

L AR ol ) Sevinl Number COM0877

Sa1 Pazawend LAN Cermection Sialus Cermecied
WIFI Connection Status: Cormacted
Host Name (FODN Bonehi loral

Figure 122: WIFI configuration finished
11. Disconnect the LAN connection of TBX3000A to finish the configuraiton.

12. Repeat the procedure to configure the TBX3000A on the bench and change its
host name as BenchX, in which X represents the number of the bench that
TBX3000A is placed.

13. After configuring the TBX3000As, they will be connected to ‘school lab 1’
network automatically, and will be automatically recognized as the bench
configured by the TSL3000B software running on the lab server.
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NOTE. The host name of TBX30004 must be changed on the LAN configuration
page.

Two TBX30004s cannot have the same host name, otherwise the later host name
will be displayed as “BenchX-2.local”, as shown on the welcome page below, and
cannot be recognized by the TSL3000B software.

Welcome Page

Welcome Page

i N Instrument Model TBX3000A

Firmware Revision: 200
WIFI Configuration

Serial Number: C010677

Set Password LAN Connection Status: Connected

WIFI Connection Status: Connected

Host Name (FQDN): Bench1-2 local

Figure 123: Two TBX3000As with the same host name
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Configure the TBX3000A 1. Select LAN Configuration on the left side and click Modify, as shown in the
for the LAN network following figure. Input “admin” if password is required.

T
@ hitp://192168.1.101, pL~-c ﬂ @ LAN Configuration

LAN Configuration

Welcome Page

Hostname: Bench1
LAN

TCP/IP Configuration Mode: Manual
IP Address: 192.168.1.101
Set Password Subnet Mask: 255.256.255.0

WIFI Configuration

Default Gateway: 192.168.1.1

Connect Status: Connected

Speed 100Mbs

Figure 124: LAN configuration

2. Change the host name of the bench to which the TBX3000A is connected, as
shown in the following figure.

[ . | . =
Modify LAN Configuration

= puriomalic

TCRIP Configunaton Made:

WIF| G i maraial

2ot Pasavecet I Aderess: fEeEAa
Subned Mask: pPEEsEsn
Defaull Gatewy [—
st Marme: | Berchl l

Figure 125: Modify LAN configuration

3. Select Automatic next to TCP/IP Configuration Mode. Or you can select
Manual, then input the IP address, subnet mask, and default gateway.

4. Click Submit to complete the configuration.

NOTE. After clicking Submit, the TBX3000A could be disconnected to the
computer that is used to configure the TBX3000A because the default IP address
of the TBX3000A is modified. To check the IP address and host name, you need to
log in the router configuration page.
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Arrange the bench and lab layout

Arrange the bench layout

TekSmartLab User Manual

This case supposes that there are four instruments placed in one bench: an
oscilloscope, an arbitrary function generator, a digital multimeter, and a power

supply.

Take the following steps to arrange the bench layout:

1. Click Setting -> Bench/Lab Layout Config and choose the Bench Layout
Configuration tab.

2. Choose the four-instrument layout, as shown in the following figure.

Bench Layout

Figure 126: Four-instrument bench layout
3. Choose the four instruments, as shown in the following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration

Bench Layout
1 Oscilloscope ~ 2 Abitrary Function Generator
CH1 Output [ON

~ Example Example

[CHt ]
50.0mV'

3 Digital Multimeter 4 X
Scope
AFG

DMM

-123.125 mV PWS
Example Example

Default Setup

nent DGV

1000 V

Figure 127: Choosing instruments
4. Click Apply.

5. Click Yes to confirm the setting.
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Arrange the lab layout  In this case, there are 16 benches in 4 rows. The benches are numbered from left
to right, as shown in the following figure.

A & &
g &
- - &

—
w

Q- & & &

8- 8

4
&

Figure 128: Lab layout
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Take the following steps to arrange the lab layout:

1. Click Setting > Bench/Lab Layout Config and choose the Lab Layout
Configuration tab.

. Choose By Row next to Number.
. Input 4 next to Row.
. Input 5 next to Column.

. Clear the middle column by double-clicking the benches, as shown in the
following figure.

Telitronix TekSmartlab® Home Setting Administrator About

Bench Layout Configuration Lab Layout Configuration
Number Row 4 ¢ Column 5 4+ Total 16

DMM | |Se ¢ DMM |

Figure 129: Arrange lab layout
6. Click Apply to complete the setting.
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Centralized instrument 1. Click Configure Instrument on the home page, the following page is
configuration displayed.

< Back  Status Unselected [[T7] Selected Configure succeed Configure fail Unselectable

Bench Selection ) | Capiure Apply

Mode Scope

Default Setup
Autoset
Logic Analyzer

Help Everywhere

Trigger
Source ~ Type

Slope v Level

Horizontal

V-Scale V-Scale i V-Scale H-Scale

V-Position = V-Position V-Position H-Position

Figure 130: Configure instrument

2. Choose Scope in the left pane, the oscilloscope configuration page is
displayed on the right.

. Click the white arrow to hide the icons of the instruments.

. Tick Default Setup.

. Click on CH2 to disable it, and its color will turn grey.

N W A W

. Choose Disable next to Autoset, as shown in the following figure.

< Back Status Unselected [ Selected Configure succeed Configure fail Unselectable

Bench Selection | 1 2 3 4 5 6 7 8 9 10 " 12 Capture Apply

Mode

Default Setup
Autoset Disable
Logic Analyzer

Help Everywhere

Trigger

Source

Slope

Vertical & Horizontal

i cH2

V-Scale V-Scale

Horizontal
V-Scale V-Scale H-Scale

V-Position z V-Position 5 V-Position V-Position

H-Position

Figure 131: Configure oscilloscope
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7.

Click the white arrow to see all the benches, as shown in the following figure.

Bench Selection () [Capture Apply

All

o
oty Inverse

Figure 132: Bench selection

8.
9.

10.

Choose all the benches displayed in blue, or click All to choose.

Click Apply to distribute the configuration to the chosen benches. The
configured benches will be displayed in green.

Press the Autoset button on the oscilloscope, and you will get a message that
“Autoset is disabled.” on its screen.
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Monitoring a bench

Click the lab information area on the main page. You will have an overview of
the lab.

Checking the status of an ~ Using bench 1 as an example in the following figure, all the four instruments are
instrument  connected and online.

1

SCOPH AFG | DMM

PWS

Figure 133: Instrument status

If you disconnect the oscilloscope from TBX3000A on bench 1, or turn its power
off, the scope will be displayed in grey.

1

SCOPH AFG | DMM

Figure 134: Scope not online

If you connect the oscilloscope to TBX3000A or turn its power on, the scope will
be displayed in green again.
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Monitoring a bench  You can click the bench to enter the bench page and monitor the instruments, the
following figure is displayed.

< Benchi

El ol

Letaut Sehp

-39.800uVDC

Measwement DY

Rangs

Figure 135: Monitoring a bench

If you turn the horizontal scale knob of the oscilloscope on bench 1, you will see
that the waveform is also changed here.

You can monitor and control an instrument in detail by clicking the white box
in the upper right corner on the instrument pane. Using the oscilloscope as an
example, the following page is displayed after you click the white box.

Bench1
Default Setup  AutoSet ¥ Single Run /

CH1 - Mode off

Measurement

Trigger

Figure 136: Monitoring an oscilloscope

If you select Screen, a snapshot of the waveform on the actual instrument is
displayed here. You can right-click on the waveform to save it. You can click
Screen again to take another snapshot.
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Controlling an instrument

98

from the server

In the lab, if a student requires some assistance from the instructor, the instructor
is able to access the instrument from the server to help the student.

Select Waveform, the waveform is displayed in real-time on this page, as shown
in the following figure.

Figure 137: Monitoring an oscilloscope

Modify V-scale of CH1 on this page, the V-scale parameter is changed on the
oscilloscope accordingly. The waveform on this page and on the monitor of the
instrument are both changed.

If you place the mouse on top of the yellow arrow 1, an upward arrow and a
downward arrow are displayed. Right-click to select them and move them. The
V-position parameter on the oscilloscope is changed, as well as the waveform, as
shown in the following figure.

Figure 138: V-position changed
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Asset management

TekSmartLab User Manual

On the home page, you can select Administrator -> Asset Management on the
menu bar to manage the instruments.

You can set the parameters by inputting time next to Start and Stop, and then
click Query to acquire the information about the instruments, the following figure
is displayed.

Tektronix' TekSmarilab™ Home Setting Administrator About

Asset Management

Start 2016-04-11 =] Stop 2016-04-21 =}
Bench No. Model Number Query

C018001
Co46804
C080001
Co48084
co20109

i s \
C040464
\

C020014

Figure 139: Query the instruments

All the instruments that are connected to the TekSmartLab server are displayed,
including their bench number, serial number, models, and working duration.

Then you can click Export to export the result in the format of Excel.
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Create a new exercise

On the home page, you can click the plus symbol on the left upper corner of
the course information area to create a new exercise. The following figure is
displayed.

Create a new exercise

Instructor

Course nalog circuit

Exercise Demo|

Cancel

Figure 140: Create an exercise

You can input all the information and then click OK.

Now you can go to the exercise by selecting the instructor, as shown in the
following figure.

Tektronix TekSmartlab™ Home Setting Administrator About
TRIAL

= Instructor Tektronix
Tektronix
Professor A

T N Saved Config Exercise Material
ourse Scope tutorial

Exercise  Rise and fall time meas - Configurs

Instrument
Report Template

Tetal Instruments
Normal
Emor

Disconnected Test Report

Figure 141: Selecting an instructor
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Instrument configuration saving/recalling
Take the following steps:
1. Select Tektronix next to Instructor.
2. Select Scope Tutorial next to Course.
3. Select Rise and fall time measurement next to Exercise.
4

. Click the Save Config area.

NOTE. You may find that AFG and Scope are already selected with some
parameters configured. You can directly apply these parameters or configure
them by the following steps.

5. Select the AFG and Scope by ticking the white box in the left upper corner of
each area, as shown in the following figure.

< Back  status Unselected [ Selected Configure succeed Configure fail Unselectable

Bench Selection 1 2 3 4 5 6 7 8 9 10 1 12

AFG O DMM

CH1 Output |ON v CH2 Output |OFF v
. 2 Default Setup

Measurement

Waveform Mode Range
Sine Continuous v

Frequency Amplitude
1 kHz 1Vpp

Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

H-Scale

200 mV/ 400 us

Figure 142: Select Scope and AFG
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6. Configure the AFG and Scope, as shown in the following figure.

< Back  status Unselected [ Selected Configure succeed Configure fail Unselectable

Bench Selection 1 2 3 4 5 6 7 8 ) 10 " 12

O

CH1 Output Output SRS ~
e utput put Default Setup

Measurement

Waveform Mode Range

Sine Continuous
Frequency Amplitude

1 kHz 1Vpp

Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

1 H-Scale

200 mV 00 mV 400 us

Figure 143: Configure Scope and AFG

7. Click Save after the configuration. This configuration is saved under this
exercise.

8. Click the white arrow to see all the benches, as shown in the following figure.

< Back Status Unselected Cl Selected Configure succeed Configure fail Unselectable
Bench Selection
il

18

=
= o2, Inverse

Waveform Mode

Sine Continuous
Frequency Amplitude

1kHz 1 Vpp

Scope

Default Setup
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current
Output

Set Voltage
Set Current

H-Scale
200mV 200 mV 400 us

Figure 144: Apply to other benches
9. Select the benches to be configured.

10. Click Apply to apply the configuration to all the selected benches.
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Student access

This case uses bench 1 as an example. The student visits the webpage of bench 1
through the computer on bench 1 or his or her own smart device.

Bench webpage  For the instructor to create access for the bench webpage, take the following steps:

1. Select Setting -> General Information on the menu bar, as shown in the
following figure.

Tektronix TekSmartlab™ Home Setting Administrator About

General Information
Lab Information

Lab Name TekSmartLab

QR Code Generation QR Code Print Preview

SewverlP Wi

Single Bench NO.

Width(Unitmm) 240

hitp//192.168.1.66/login.aspx?deskid=1

Print

Figure 145: Generate bench webpage
2. Input the server IP:

= If the server and the student computer on the bench are connected to the
same campus network, input the server IP address in the campus network.

= If the server and student’s smart device are both connected to the
TekSmartLab network, input the server IP address in the TekSmartLab
network.

3. Select Single. The QR code and web address for the bench are shown in
the QR Code Print Preview area.
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For the student to access the webpage, you can:

B Type in the address in the computer web browser.

B Scan the QR code with the smart device.

®m  Type in the address in the web browser of the smart device.

The following figure is displayed after you type in the address in the computer
web browser. You may bookmark this page.

mi @ hitp://192.168.1.66/login aspxdeskid=1
i

File Edit View Favoites Tools Help

Favorit
Tektronix
Lab Name: TekSmariLab
Bench: 1
Course Name: Scope tutorial
Exersise: Rise and fall time measurement
Student Name:

Student ID-

[JRemember me
Scope Snapshot

Figure 146: Visiting bench webpage

Sharing exercise material

In the course information area, you can click Exercise Material button to share
the exercise material with students. The following figure is displayed.

Exercise Material

Figure 147: Share exercise material
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You can click Add to add one or more files to share with the students, like
instrument reference manual or exercise videos, as shown in the following figure.

ST_AFG_Cursor_Ri
TBS1000B-El

Delete

Figure 148: Add exercise material
For the student to access the exercise material:

1. On the bench webpage, input your name and ID.

NOTE. Your student ID should be unique, whereas the student name does not
need to be unique.

2. Select the Material tab, the exercise materials are displayed as shown in
the following figure.

- -
m | & hittp://192.168.1.66/ CoursewareView.aspx

- File Edit View Favorites Tools Help

IA ST_AFG_Cursor_Rise-Fall-Time_Measurement.pdf

IA TBS1000B-EDU-Oscilloscope-DataSheet-1_0 pdf

Figure 149: Access exercise material

3. Select the file and click Download.
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Test report editing
For an instructor to edit the test report template:

1. In the course information area, click Report Template button. The following
figure is displayed.

Test Report Template

Introduction:

Report template can only be in the format of .docx created by Microsoft Word. It will be transformed to HTML when it is loaded in the web page on students' devices.
When the template in word is transformed to HTML, only the texts and images are kept. You can click Preview to see the uploaded template in HTML or refer to the
example shown below.

Test Report Template iC: g x86) \Tektr

Preview

Example
Report template in * docx format Report template in HTML format

ot be saved

o Text and image can be saved. e Textand image can be saved
i
REVOLUTIOKERING. ==

)
REVOLUTION:gRiNG. 3 ek morss
REVOLUTIONgRiNG. ——

® Headerand footer cannot be saved. ® Header and footer cannot be saved
g== i
saved unless it is changed to be an image. 9 g

( )" = e (m kon-k,
crar =Y ()t

Figure 150: Edit report template
2. Click Preview to check the existing template.

3. You can also create your own template and click the =1 to import it to
the server. Only the *.docx file format is supported.
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For the student to edit and submit the test report.
1. Select Test Report tab on the webpage.
2. Click New Report, the following figure is displayed.

(-__ P~ &192168166

Edit View Favorites Tools Help

Create New Report .

Report Name

Rise and fall time me x

OK | Cancel

Figure 151: Create a new report

3. Click OK, the following figure is displayed. The report template created by
the instructor is loaded automatically.

h ¥ ® EEZ=SE A A fontfamy- FontSzes B J = v S~

Test Report Template

® Instructor: Tektronix
@ Courser: Scope Tutorial
® Exercise: Rise and fall time measurement

Student name:‘
Student ID:

OBJECTIVES 9

After this lah eyerrise leamer will he ahle fo

Figure 152: Edit new report

4. Edit the report by entering the name and 1D, along with other content.
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5. Under Test Result, click Scope Image button to insert scope snapshot, and
the following figure is displayed. The student ID is watermarked on the
oscilloscope snapshot.

[(=|TestRepot  J&"Material

Insert RSl EN m

- 3 ® E =E = E A~ A - FonFamy- romszes~ B [ =~ IS
1 5L RESUIL
ek Rur

v p

Figure 153: Scope snapshot inserted

6. Click Submit.

7. Click Download to download the file and unzip it so that you can edit it in a
word document, as shown in the following figure.

dditional.files 4/20/2016 11:54 AM _ File folder
£ Rise and fall time measurement.html L ——
Open
Open in Same Window
Print
7-Zip »
Open with »| @ Google Chrome
@ Internet Explorer
@ Word (desktop)

Send to 13
B cut
A '

Create shortcut

Choose default program

Delete

Rename

Figure 154: Open the test report on the computer
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For the instructor to query and check the test report.

1. Click Test Report on lower right side of the home page to check student’s
test reports.

2. Input the time next to Start and Stop and click Query to get the students’
report, the following figure is displayed.

Instructor

Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
Tektronix
2016-04-21 10 Tektronix
Tektronix

Te
Te
Te
Te
Te

onix
Tektronix
Tektronix

Test Report

[Thursday, April 21, 2016 = Stop

Student Name

Course Name

Scope tutorial

Scope tutorial
Scope tutorial

Scope tutorial

Course
Bench NO.
Student ID

Exercise
Rise and fall time measurem

Rise and fall time measun

Rise and fall time measurem... |3

Rise and fall time measurem.

Rise and fall time measurem... |5

Rise and fall time measurem... |6

Rise and fall time measurem
Rise and fall time measurem
Rise and fall time measurem
Rise and fall time measurem.
Rise and fall time measurem
Rise and fall time measurem

Rise and fall time measurem.

Rise and fall time measurem

Thorsdsy, horil 21, 2015 =]

Student Name Student ID

Tina Tang
Gary Wee
Chelsa Tang
Marry Ying
Patrick Ma
BryceLi
Richeal CHEN
Jacky Wang
Tony Wu
Harry Ji

Detail Export Report List Export Report Files Delete

Figure 155: Query and check test report

3. Double-click a report created by the student, or choose a report and click
Detail to check it.

4. Click Export Report List to export the query result to an Excel document.
5. Click Export Report Files to export all the text reports.

6. Sclect the report and click Delete to delete the report.
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Campus Level TekSmartLab

When one lab manager must manage multiple labs, it can be a challenge to
manage all of the instruments efficiently since the lab manager needs to spend
time visiting each of the different labs. With campus level TekSmartLab, the
lab manager can centrally control and monitor the instruments in different labs
remotely from his own office.

Campus
Network

Office of lab
manager

Figure 156: Campus level TekSmartLab network diagram

As shown in the example above, TekSmartLab systems are setup in each of the
labs and the lab servers are connected to a local area network, such as a campus
network. TekSmartLab software is installed on the lab manager's computer, which
is connected to the same local area network. When the IP addresses of lab servers
and lab manager computers can communicate with each properly, lab manager
can access to the lab server in certain lab, and centrally control and monitor the
instruments in that lab remotely.

Here is the process to setup campus level TekSmartLab through a campus network
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For lab server in a specific 1. Refer to Installing TSL3000B to install TSL3000B properly on the lab server,
lab (See page 8, Installing TSL3000B.).

2. Start TSL3000B TekSmartLab software, and click Setting -> Remote Lab
configuration on the menu bar.

3. Select IP address, which should be the IP of lab server when connecting to
campus network.

4. Set Allow Remote Control to be Yes, and set the Access Password, for
example “123”, and click Save to finish.

Telkironix TekSmarilab Home Setting Administrator  About

Remote Lab Configuration

Figure 157: Remote lab configuration interface on the lab server

For lab manager computer 1. Refer to Installing TSL3000B to install TSL3000B properly on the lab
in the office manager computer, (See page 8, Installing TSL3000B.).

2. Connect to campus network, and check the communication with lab server
through pinging the lab server IP.

B CAVWindowshSystem32\PIMG.EXE

Figure 158: Pinging lab server IP from lab manager computer

3. Start TekSmartLab software on the computer and click Setting -> Remote
Lab configuration on the main interface.
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4. Click Add and input the IP address and Access Password of the lab server
to be connected.

Tektronix TeksmartLat Home Settng Administrator About

Remote Lab Configuration

Cancel

Figure 159: Remote lab configuration interface on lab manager computer

5. Select the added lab server IP address and click Connect. It takes up to one
minute to finish, and the status will be changed to Connected once succeed.

Tektronix Teksmardlab”  Home Setting Administrator About

Remote Lab Configuration

Within campus

Figure 160: Connect to lab server from lab manager computer
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6. On the main interface, switch between different labs via arrows.

Tekironix TekSmartlat Home Seting Administrator About

< TekSmartLab

+ Instructor NAME1

Saved Config
Course

Bench

Test Report

Figure 161: Main interface on lab manager computer

The interface will be shown with yellow boarder when connecting to a lab server
remotely.

Bench1

Default Seius

Measurement

Figure 162: Connecting to a lab server remotely

NOTE. Even with a trial version software, lab manager can control and monitor
the instruments in different labs remotely. However, if lab manager wants to export
asset information and test reports of a lab remotely, it is necessary to purchase a
license (TSL3000B-FL) to active the software on lab manager computer.
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Previous software version installed

If the previous version of TSL3000B is uninstalled, but you can’t install the new
one, take the following steps:

1. Uninstall the previous version and restart the computer.

2. Find the TekSmartLab folder in C drive.
= For 64 bit, the directory is C:\Program Files (x86)\Tektronix\TekSmartLab
= For 32 bit, the directory is C:\Program Files\Tektronix\TekSmartLab\

3. Copy the folder to another directory, and then delete the folder.

4. Install the latest version of TekSmartLab software.

NOTE. Make sure that you copy and back up the data before you delete the folder.

If you need to restore the data of previous version, please contact your dealer or
Tektronix sales representative. They will contact engineers from the production
line to assist you to restore your previous data.

Software can’t be displayed properly

After you open the software, the screen page can’t be displayed properly, as
shown in the following figure.

Tektronix: Teksmartop™  Home in About

TekSmartLab

Instructor  Tektronix

Scope tutorial

Exercise  Rise and fall time measur ~

Report Template

180 Total Instruments

Figure 163: Screen page not displayed properly
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To modify the screen
resolution

To modify the font size

116

There could be two reasons for this problem:

m  Screen resolution: If the screen resolution is lower than 1366*768, the

software screen page can’t be displayed properly.

= Font is not the right size.

Moo=

Change the appearance of your displays

| Detea |
e
Display: 1. Mobile PC Display v

Ty —

Resolution:

High
5| 1366 x 768 (recommended)

' | 800 % 600

ok || ancel || aeey. |

Figure 164: Set the screen resolution

3. Click Apply.

1. Right-click on desktop and select Personalize.

2. Select Display, the following figure is displayed.

8 » Control Panel * All Control Panel ftems » Display v | 44 )| Search Contral Panel P

Control Panel Home

Make it easier ta read what's on your screen

itpe et You can change the size of text and other items on your screen by cheesing one of these aptions. Ta
r

temporarily enlarge just part of the screen, use the Magnifjer tool.

Adjust brightness
% Calibrate color
Change display settings i Frsew
Connect to a projector
Adjust ClearType text
Set custom text size (DPT)

@ Medium - 125%

s Some items may not fit on your screen if you
a this resolution

choose this setting while your display is set | Agp

Personalization

Devices and Printers

Figure 165: Set the font size
3. Choose Small-100% (default).
4. Click Apply.

5. Log off to complete the modification.

Right-click on desktop and select Screen resolution.

Set the resolution to 1366*768, as shown in the following figure.
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TBX3000A configuration page can’t be logged in
Take the following steps to solve this problem:
1. Restart the TBX3000A and the computer used to configure TBX3000A.

2. Check the LAN configuration of the computer to see whether it has the correct
IP address and gateway.

3. Check whether the TBX3000A is properly connected to the computer by
the LAN cable.

4. Check the LAN indicator of the TBX3000A to see whether it works properly.

NOTE. For steps 2 to 4, please refer to Configure the TBX3000A4, (See page 4,
Configure the TBX3000A.) for more information.

5. [If all above steps fail, try a different web browser or change the computer.

6. You can also try press the RESET button for 5 seconds on the TBX3000A to
reset it to factory default, and then configure it again.

Benches disconnected

In the TekSmartLab WIFI network, the TBX3000A is configured, but all the
benches are displayed as disconnected on the screen page of TekSmartLab
software. Below is an example showing that all benches are disconnected.

1 2 3 4 5 6 7 8
SCOPE AFG | DMM  SCOPE AFG | DMM  SCOPE AFG | DMM  SCOPE AFG | DMM  SCOPE AFG | DMM  SCOPE AFG | DMM SCOPE AFG | DMM  SCOPE AFG | DMM
PWS PWS PWS PWS PWS PWS PWS PWS

SCO AFG | DMM SCOP AFG | DMM SCOP AFG | DMM SCOP AFG | DMM SCO AFG | DMM SCOF AFG | DMM SCOP AFG DMM SCOP AFG | DMM
AFG | DMM  SCOPE AFG | DMM  SCOPE AFG | DMM  SCOP AFG DMM  SCOPE AFG | DMM
PWS

Figure 166: All the benches not connected

Take the following steps:

1. Host Name of TBX3000A must be changed on LAN configuration page.
If it is changed on the WIFI configuration page, press Reset button on the
TBX3000A 5 seconds to load its default setup and configure it again.

2. Check whether the Host Name of the TBX3000A connected to a certain
bench, such as Benchl is correct. The host name must be in the form of
BenchX, in which X means number of the bench.
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3. Check whether the WIFI indicator of the TBX3000A blinks twice at a time
to see whether it is connected to the WIFI network. If the TBX3000A is not
correctly configured, please refer to Configure the TBX3000A, (See page 4,
Configure the TBX3000A4.) to configure it again.

4. Check whether the firmware of the TBX3000A is the latest version, which
is V2.0.0 or above. If not, please visit www.tek.com and search using the
search phrase “TBX3000A firmware”. Then download the latest version and
upgrade the firmware.

5. Check whether the server is connected to the network before open the
software.

NOTE. Make sure that the server is connected to the network before you open
the software.

6. Check the TSL3000B version on the lab server. It should be V3.0.0 or above.
If not, please search and download the latest version from www.tek.com.

7. On the lab server, ping the IP address of the TBX3000A on a certain bench,
as shown in the following figure. You can get the TBX3000A IP address
from the router configuration list. If this does not work, check the network
configuration.

Pinging 192.168.1.151 with 32 bytes of data:

Reply from 192.168.1.151: bhytes=32 time=105ms TTL=64
Reply from 192.168.1.151: bytes=32 time=41ims TTL=64
Reply from 192.168.1.151: bhytes=32 time=5%ms TTL=64
Reply from 192.168.1.151: bhytes=32 time=12ms TTL=64

Ping statistics for 192.168.1.151:
Packets: Sent = 4, Received = 4, Lost = 8 (@x loss).
Approximate round trip times in milli-seconds:

Minimum = 12ms, Maximum = 105ms, Average = S54ms

Figure 167: Ping TBX3000A IP address
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Unstable connection in a 15-bench or above WIFI network

In a WIFI network of 15 benches or above, the connections of the benches are
quite unstable, even though all the devices in the network are properly configured
with the latest firmware.

This problem is mainly caused by the WIFI network configuration. Take the
following steps:

1. Check the network configuration. Using 30 benches in this example, it is
highly recommended the network is supported by 1 router + 2 APs. Ifit’s
only supported by 1 router, it’s possible that not all benches can be distributed
with an IP address.

2. Check the router and AP configuration on the router management page to
make sure that the router has enough IP resources. Set the number of the
Max. Associated clients larger than the number of devices that are connected
to the network. For example, if the network is connected to one lab server, 30
benches through TBX3000A, and 30 smart phones, set the number of Max.
Associated clients to be greater than 61.

3. Check the IP address of the server to make sure that the server is properly
connected to the network. If the IP address of the server says 169.X.X.X, it
means it is not assigned with correct IP address. Check the configuration of
the router and APs. You can connect the server to another AP and assign a
static IP address to it.

4. On the lab server, ping the IP address of a known bench. If this does not
work, check the network configuration.
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Unstable connection in a 20-bench LAN network

In a LAN network of 20 benches, the connections of the benches are quite
unstable, even though all the devices in the network are properly configured.

This problem is mainly caused by the router configuration or the MAC address of
the TBX3000A.

For router Configuration:

1. Check the IP address of the server. If it’s not correctly assigned, configure
it again.

2. Check the configuration of the router and make sure that all the benches are
properly connected to the router.

3. On the lab server, ping the IP address of a certain bench. If this does not
work, check the network configuration.

For MAC address conflict:

4. If your TBX3000A is manufactured before May 2016, there might be an issue
of MAC conflict. Please contact Tektronix representative for instructions
on how to change the MAC address.
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Instruments are displayed disconnected

TekSmartLab User Manual

On the screen page of the software, the bench is displayed as connected, but
the instruments are displayed as disconnected. However, the instruments are
turned on and connected to the TBX3000A through USB cable. Below is an
example that TBX3000A on bench 1 is online, but the instruments on bench 1
are displayed as disconnected.

Figure 168: Instruments on bench 1 displayed disconnected
Take the following steps:

1. Visit www.tek.com to check the specifications of TSL3000B to make sure the
instruments are supported by TekSmartLab software.

2. Check that the version of TSL3000B is the latest version V3.0.0 or above. If
not, please visit www.tek.com and search “TSL3000B”. Then download the
latest version and update the software.

3. Check that the firmware of TBX3000A is the latest version V2.0.0 or above.
If not, please visit www.tek.com and search “TBX3000A firmware”. Then
download the latest version and upgrade the firmware.

4. For AFG1000 and TBS1000B-EDU instruments, check that the firmware for
your instruments are the latest version. If not, visit www.tek.com to download
the latest version and upgrade them.

5. For oscilloscopes of the series TBS1000, TDS1000C, TDS2000C etc., check
whether their USB ports are set as computer mode, If not, press Utility->
Options —> Rear USB port -> Computer, and then restart the instrument.

6. For DMM4000 series instruments, the RS232 port should be configured as
follows:

= Baud rate: 9600

= Polarity: None

= Data bit: 8 data bits

= Flow control: None

= End of life character: Carriage Return and Line Feed

= Computer and terminal Mode: Computer
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Instrument parameters are not displayed

On the screen page of the software, the bench and instruments are displayed as
connected, but the instrument parameters are not displayed or an error message
appears when you enter the instrument page.

This problem is mainly caused by the firmware of the TBX3000A or other
connected instruments. Or the connected instruments are not supported.

Take the following steps:

1. Check that the firmware of the TBX3000A is the latest version V2.0.0 or
above. If not, please visit www.tek.com and search using the seach phrase
“TBX3000A firmware”. Then download the latest version and upgrade the
firmware.

2. For AFG1000 and TBS1000B-EDU instruments, check the the instrument
firmware is the latest version. If not, visit www.tek.com to download the latest
version and upgrade the instruments.

3. Upgrade the firmware of the bench instruments to the latest versions, which
are available on www.tek.com.

4. Check the TSL3000B datasheet, to see whether the instruments are supported.

Students can’t log in the bench webpage

The students can’t log in the bench webpage either through bench computer or
smart device.

This fault can be caused by two reasons:
m IS configuration on the server.

B Network configuration of the bench computer or smart device
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For IIS configuration 1. On the server with the TSL3000B running, open a web browser and input
the address of “localhost”. If the IIS is properly configured, a “please input
bench number” dialog box will be popped up and the following figure will
be displayed.

de iy 0~ ¢ || @ TeksmartLab

Fil

Telitronix

Lab Name: TekSmartLab

Bench:

Course Name: Scope tutorial

Exersise: Rise and fall time measurement
Student Name:

Student ID:

Remember me
Scope Snapshot

Figure 169: Localhost webpage

2. If the IIS is not properly configured, please refer to /IS Installation and
Configuration, (See page 27, I1S installation and configuration.) to check
every step of the configuration.

If the following error message appears when configuring the IIS, then the 80
port conflict is the fault.

Internet Information Services ({I5) Manager &

If"-_-"-.l This Web site cannot be started. Another Web site may be using the
‘S# same port.

Figure 170: 80 port conflict
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Use these steps to clear the fault:.

1. Start Windows Task Manager (Ctrl+Alt+Del) to find which program is
using port 80.

2. Choose View -> Select Columns. The following figure is displayed.

1% Windows Task Manager =|=] =
File Options View Help
| Appications | Processes |Services | Performance | Networking | Users |
r—— Select Process Page Columns
Image: - —
Search{| Select the columns that will appear on the Process page of Task Manager.
Searchlf
Searc® | AT PID (Process dentier)
serviced| ||/ User Mame
Skype.l | | [7] Session ID
SkypeCH| | [@] CPU Usage
Skypectl | [ ceuTime F
i [Z] Memory - working Set
5p00lsV | | 7] Memory - Peak Working et
sdlserve [7] Memory -Working Set Dalta -
sqhvitey Memory -Private Warkirg Set
stacsv.qil | [7] Memory - Commit Size
sttray.&i| | 7] Memory - Paged Poal
swchosf [7] Memory -Non-paged Pos!
svehostll | 7] page Faults
svehosll | [ page Fault Delta
svehostlll | 7] Base Priority b
suchost]
[ —
e -
suchost] i 5
il
Show processes from al users
Processes: 106 CPU Usage 5% Physical Memory: 51%

Figure 171: Window task manager

3. Select PID (process Identifier ).

. Click OK.

4
5. Click Processes to display the programs with PID information.
6

. Under Start >> All Programs >>Accessories, right-click Command Prompt

and select Run as administrator.

7. Input command “netstat -nao” and press enter to finish. (Note the space
between netstat and -nao)
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8. Identify the PID that is using port 80 (refer to Local Address as below) , and
find the program name in Task Manager. It is “Skype.exe” in the example
below.

ommand Promp

Microsoft Windows [Uersion 6.1.76811
Copyright _(l?) 280? Microsoft Corporation. All rights reserved.

U=Snetstat —nao |

Active Connections

~Tocal Addresss State

= LISTENING

B LISTENING

LISTENING

a

v £

a S

File Options View Help

a : _f

![ Appl\catuns_f Processes | Services ; Parﬁrmanca_s_hﬂ?_rking :—Users |

r

=

Image Mame PID User Name CPU  Memory (... %

Searchindexer. exe 5276 SYSTEM 00 8,760 K

B

a SErvices.exe 620, SYSTEM 0o 4,884 K

Skype.exe 7328 byani an 98,968 K

8 SkypeC2CAutoUpdateSve.exe 2158 SYSTEM i} G40 K
SkypeC2CPNRSve.exe 2256 NETWO... 00 1,216 K
smss.exe 396 SYSTEM 0o 300K
spoolsy. exe 700 SYSTEM oo 3,516 K
SppsvC.exe 3980 NETWO... oo 1,040 K
sqlservr.exe 2592 NETWO... 00 28,732K
sqlwriter.exe 3272 SYSTEM i3] 1,328K

Figure 172: Command prompt

9. Uninstall the program that is using port 80 or change the port the program is
using. The following figure shows an example of changing the port that Skype.

3 Shyp=r - Opters i

B Geners Connection: Set up how Skype connects to the nternet

Use port |1 nnections

[T U= part 80 and 443 for

nal incoming connections

Automatic proxy detection =

| Enable proxy authentication

7| Erabie e
Alaw direct cannechans to your contacts oy L2 ]
e
Gther things you can do

Save cancel |

Figure 173: Changing port for Skype
10. Choose Tools -> Options -> Advanced -> Connection.
11. Unselect “Use port 80 and 443 for additional incoming connections”.

12. Click Save to finish.

125



Troubleshooting

For network configuration 1. Check that the bench computer or smart device is connected to the same
of the bench computer or network that the lab server is connected to.
smart device, use these 5
steps

Make sure that the server IP address is static.

3. Make sure that the IP address input in the TSL3000B general information
page is correct, so that the computer and smart device input the correct one to
be connected to the server.

4. If it still does not work, switch to another web browser.

5. The student can try to ping the server IP. If it does not work, check the
network configuration again.
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